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What's New

Data Preview

Whenever you are working with a transaction table, dimensions table, or behavior
table, you can view the first one thousand rows of data in the table. This feature
enables you to verify the underlying data without leaving SAS Profitability
Management.

Export Rules and Associations

You can export all rules and all associations. This feature enables you to easily move
the rules and associations between models or between servers.

Audit Log

SAS Profitability Management maintains an audit log of the the changes to a model.
The audit log enables you to determine the changes made, who made them, and
when they were made.

Detailed Report Filtering

When filtering a detailed report, you can filter on specific dimensions and levels. This
feature provides you further flexibility with detailed reports.

Enhanced Rule Matching

You can match fields between columns in a behavior table and a transaction table,
instead of matching a single rule to a single row in a behavior table. This feature
enables you to to create a single rule for a single type of field matching, which makes
modeling much easier.
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Behavior Table

The behavior table lists each source of a transaction cost with its appropriate values. A behavior table contains
the following columns:

Position [[Name Maximum Length Description
1 Time Char 32 The period for the transaction costs
2 ID Char 32 The identifying reference for the behavior
3 Name Char 32 The name of the behavior
4 Total Value Numeric 8 The total source amount that will be spread
5 Unit Value Numeric 8 The unit cost for each transaction with this source

In a behavior table, consider the following rules:

. The columns must appear in the order that is shown.
. Each column must have the length that is shown.

. The name of the column is arbitrary.

Note: Only one of the Unit Value and Total Value columns can contain a non-zero value for any row of the
behavior table.

The following picture shows a sample behavior table:



Feriod ] Mame Total Walue LInit “Walue

= YIEWTABLE: Pni_buzz.Behavior =]
Tirne I t ame Taotalalue it alue |i|
1 2006_07_Actual 20002  CCT_OTP_Manage tranzactions 164680817 1]
2 2006_G1_Actual 20003 ATM_CHE_Check balance 1] 1.44509029
3 2006_G1_Actual 20004 ATM_CHE_Depaosits 1] 0.17B800234
4 2006 (1 _Actual 20005  ATM_CHE_Fund Transfer 1] 0.80104504
5 2006_G1_Actual 20008 ATM_CHE withdrawals 1] 381449376
E 2006 01 _Actual 20007 ATM_CRC wWithdrawals 1] 1.52364654
Fi 2006 01 _Actual 20008 ATM_OTP_Manage transactions 212489.27 1]
2 2006 01 _Actual 20003 ATM_REC Deposits 1] (. 10840E591
g 2006 G _Actual 20010 ATM_Sav_Check balance 1] 212900245
10 200607 _Ackual 20011 TH_Sav_Depogits 023142294

,-_-" ~ 1_4 1 _ S Transf 1.17E836E1
T P
2127 | 2006_04 Actual 13001 Cre unds

0 1
2122 | 2006_04_aActual 13002 Charge For Funds 0 1
2123 | 2006_04_aActual 14001 Provizion For Lozses 0 1
2124 | 2006_4_Budget 10001 Credit Card interest Income 0 1
225 | 2006_004 Budget 10002  Loan Interest lncome ] 1
226 | 2006_004 Budget 10003  Mortgages Income ] 1
227 | 2006_004 Budget 17001 Savings |nterest Payments ] 1
2128 | 2006_004 Budget 11002  Certificates of Deposit Paymentz ] 1
2129 | 2006_04 Budget 11003 Inwestment Secunties Pavments 1] 1
2120 | 2006 04 Budget 12001 Credit Card Fees ] 1
2131 | 2006_04_Budget 12002  ATM Fees 0 1
232 | 2006_04 Budget 12003 I;eestment Account Fees 1] 1
2133 | 2006_04 Budget 12004  Checking Account Fees 1] 1
2134 | 2006_04_Budget 13001 Credit for Funds 0 1
2135 | 2006_04_Budget 13002  Charge For Funds 0 1
2136 | 2006_4_Budget 14001 Provizion For Lozses 0 1 -




‘ = H e ‘6. Calculate a Model

Calculating a model takes the transaction tables in your input directory, applies
assignment rules in the model to make calculations, and stores the calculation results
in columns that are appended to your transaction tables in the output directory.

1. In any workspace, select a model.
2. Select Actions k Calculate Model.
The Calculate wizard opens.

3. On the Period Information page, select the periods to calculate, and then click
Next.

Note: Because each transaction table is associated with one period, when you
recalculate a model, you do not need to recalculate all of the transaction tables.
For example, you can calculate January, and then February as a separate
calculation. You do not need to process a single period's transaction table more
than once as the months proceed through the year.

4. On the Table Groups page, select the table groups to include in the calculation,
and then click Next.

5. On the Cube Generation page, select the cubes to generate, and then click
Next.

6. On the Concurrent Sessions page, select the number of concurrent sessions to
run, and then click Finish.

A progress window appears.

Note: The progress window appears only if you have previously generated
cubes for this model.

7. When the calculation finishes, click Details to view the message log.



Calculate a Model

1. In any workspace, select a model.
2. Select Actions ¥ Calculate Model.

The Calculate wizard opens.

E@ SAS Profitability Management - Bank_Model

File Edit ‘“iew | Actions Help
=)

Select Actions = Calculate Model ——

|| Mode |

Refresh

Tranzactions

M arme | Pericd =
) ABMCost o
----- qu CallCenter

[ =2 N P =
1| | _’l_l

3. On the Period Information page, select the periods to calculate, and then click Next.

Note: Because each transaction table is associated with one and only one period, when you recalculate a model
you do not need to recalculate all of the transaction tables. For example, you can calculate January and then
February as a separate calculation. You never need to process a single period's transaction table more than once
as the months proceed through the year.

i Calculate _ O

Period Information

Select the periods to calculate.

Periods:

select periods —» Actual > 2006 > 2006_01

Budget > 2006 > 2006_01
Actual > 2006 > 2006_02
Budget > 2006 > 2005_02
Actual > 2006 > 200603
Budget > 2006 > 2006_03
Actual > 2006 > 200604
Budget > 2006 > 2005_04

EEREEEEE
P 0 0 0 D 0 T

& Bk Mt » | Finizh I Cancel

4. On the Table Groups page, select the table groups to include in the calculation, and then click Next.



i Calculate

Table Groups

Select the table group you want to run in the calculation,

T able groups:

Select tahle groups—*= ABMCost
CallCenter
Reverue
weh Costs

¢ Back P et = | Finizh I Cancel

5. On the Cube Generation page, select the cubes to generate, and then click Next.

i Calculate

Cube Generation

Select the cubes that pau want generated.

Summary reports:

Select cubes —m & BME_aI_Dim_&l_Meas
% BMHE_AN_Di_FullDetails
5 BME_al_Dim_FulDetails

< Back M ext > Einizh Cancel

6. On the Concurrent Sessions page, select the number of concurrent sessions to run, and then click Finish.

A progress window appears.



i Calculate O =
i)

Concurrent Sessions

Specify the number of concurrent sessions you want to run,

Mumber of Concurrent Sessions: I 1 3:

_, ........ {Ea‘i ......... | Mex': :} | IEIHTI ':ar":el |
Model Calculate operation |

\i‘) Operation in progress. ..

Executing generated code. .

[Eanze| |

Note: The progress window appears only if you have previously generated cubes for this model.

7. When the calculation finishes, click Details to view the message log.

SAS Profitability Management - buzz_Bank_Model

L.}
\!J) Trangzactions calculated.

Click Details nx | copuaCiphead | [y Detabcc |

13 The SAS Swstern 10:14 Tuesday, Septermber 19, EEIEIiI
241 I '

342 | Copyright [2] 2006 by SA5 Inatitute [nz.

a4 | 545 Campuz Drive, Carg, MC 27513 USA

44 | - &l rights rezered

45 :

45 |PRODUCT: |5A5 Profitability bManagement
347 | DESCRIFTIOMN:| Template for SAS program to calculate model

L [SOURCETYPE: | PROGRAM -
X . | S







Results of a Calculation

The following picture shows a sample transaction table before and after a calculation. The calculation has added three new columns to the transaction table in the
output directory:

’Driver Quantity ’The quantity calculated by the driver formula
]w ’The calculated cost for the transaction
Behavior The row fr_om the Behavior table that is used in the calculation for
a transaction
Transaction table before calculation Transaction table after calculation
{in the input directary) {in the output directony)
These columns are new
I YIEWTABLE: Pm_buzz.Load_trans_qla a3 @ result of calculate
Tirne | CustD | Product |CustT_l,Jpe Region | Chariti | AT | Count | AzzighmentBule 3
1 |2006 01 Actusl 00005 CHE WEM  Reg 849 ATM 51 1 ATM_CHK_Check balancs
2 |2006 01 Actusl 00002 CHK EBP Req 281 ATH 24 1 ATM_CHK_Check balancs
i iggg—g II'EI_\I'IEWTABLE: Test Load trans_qlaout
] 2DDB:Q AMT AszignmentB ule ‘ Channel | Count | CustlD | CustTyp | Praduct Region ‘ Tirne ‘ Q[:A[«IE\I"IE[L',J ‘ Ca\lf;{?;ed | Behavior 3
B |2006 07 51| ATM_CHE_Check balance | ATM 100005 WEM |CHK | Reg 843  2006_01_Actual 51 73903605026 20003
7 |2006 0T 51| ATM_CHE_Check balance | ATM 100005 ‘WEM |CHK  Req 843  2006_01_Actual 056 48692101732 21065
_ & |2mE TS E1 ATM_CHE_Check balance | ATH 100005 |'WEM | CHK  |Feg 849 | 2005 01_Actual 51 1.5941557562) 20008
,/\i'?y 4 51 ATM_CHK_Check balance | ATH 100005 ‘WEM | CHK Reg 843 2006 01 Actual 1| 84.952040183 23061
5 51 ATM_CHK_Check balance | ATH 100005 ‘WEM |CHK | Reg 843 2006 01 Actual 1| 127 42806028 21116
5 51 ATM_CHEK_Check balance | ATH 100005 ‘WEM |CHK Reg 843 2006 01 Actual 1| 169.90408038| 22021
,@\ _2,/4 7 51/ ATH_CHE_Check balance | ATH 100005 ‘WEM |CHK Reg 843 2006 01 Actual 1| 42 476020094 20058
_ 99254 006 07y 24 ATH_CHE_Check balance | ATH 100008 EBP  |CHK  Reg 281 2006 01 Actual 24 34778167072 20003
_ 93255 2006 0 g 28 ATM_CHE_Check balance | AT 100008 EBP  |CHK | Reg 281  2006_01 Actual 029 25215652682 21066
_ 93356 | 2006 0 74 24 ATM_CHE_Check balance | AT 1000028 EBP  |CHK | Reg 281 2006 01 Actual 24 0.8913674147 20003
_ 93257 | 2006 0 744 24 ATM_CHE_Check balance | ATM 100008 EBF | CHK | Feq 281 | 2006 Q1_Actual 1 84.952040189 23061
_ 93258 2006 O 74 24 ATM_CHE_Check balance | ATM 100008 EBF | CHK | Feq 281 | 2006 Q1_Actual 1 127.42806028 21116
93253 | 2006 0 7 g 24 ATM_CHE_Check balance | AT 100008 EBF  |CHK | Req 281  2006_G1_tctual 1| 169.90405038| 22021
_ 33260 | 2006 0 Ty 24| ATM_CHE_Check balance | ATM 100008 EBF  CHK  |Feg 281 | 2005 Q1_Actual 1 42 476020094 20053
_ 93281 | 2006 074y 20/ ATHM_CHE_Check balance | ATM 100025 |WEE |CHK  |Feq 523 | 2005 Q1_Actual 20 28981805893 20003
_ 93282 2006 074 20 ATM_CHE_Check balance | ATM 100025 |WEE |CHK  |Feq 523 | 2005_Q1_Actual 025 21.737545416 21066
_ 93263 2006 047 20 ATM_CHE_Check balance | ATM 100025 |'WEE | CHK  |Feq 523 | 2005_Q1_Actual 200 07428061759 20008
_ 39264 2008 U7 g 20| ATM_CHE_Check balance | ATM 100025 |'WEE | CHK | Feg 523 | 2005_01_Actual 1 §4.952040183 23061
_ 93285 | 2006 0T 4g 20 ATM_CHE_Check balance | ATH 100025 |'WEE | CHK  |Feg 523 | 2005 01_Actual 1 127.42806028 21116
_ 93285 20060 T o 20 ATM_CHE_Check balance | ATH 100025 |'WEE | CHK  |Feg 523 | 2005 01_Actual 1 169.90405038 | 22021
q 21 20 ATM_CHE_Check balance | ATH 100025 ‘WEE |CHK Reg 523  2006_01_Actual 1| 42475020094 20058
2 361 ATM_CHE_Check balance | ATH 100028 MRT  |CHK  (Reg 12 2006 01 _Actual 35 55210340227 20003
23 361 ATM_CHE_Check balance | ATH 100028 MRT  |CHK  (Req 12 2006 01 _Actual 386 33562770122 21065
24 361 ATM_CHE_Check balance | ATH 100028 MRT  |CHK  (Req 12 2006 G1_éctual 351 14150457708 20008
5 99 ATM_CHE_Check balance | ATH 100030 WEE |CHK | Req 1078  2006_01_éActual 99 14345993917 20003
% 99 ATM_CHK_Check balance | ATH 100030 ‘WEB |CHK Reg 1078 2006 01 Actual 1.04 9042519893 21065
27 99 ATM_CHK_Check balance | ATH 100030 ‘WEB |CHK | Reg 1078 2006 01 Actual 93 36768905855 20008
28 99 ATM_CHK_Check balance | ATH 100030 ‘WEB |CHK Reg 1078 2006 01 Actual 1| 84.952040183 23061
29 99 ATM_CHK_Check balance | ATH 100030 ‘WEB |CHK Reg 1078 2006 01 Actual 1| 127 42806028 21116
20 99 ATM_CHK_Check balance | ATH 100030 ‘WEE |CHK Reg 1078 2006 01 Actual 1| 169.90409038| 22021
3 99 ATM_CHK_Check balance | ATH 100030 ‘WEE |CHK Reg 1078 2005 01 Actual 1| 42 475020094 20058
N 2 142 ATM CHE Check balance | ATH 100032 WEE | CHK  Feq 858 2006 01 Actual 142 20577032184 20003 _{;I
o |-




Configure the Server

Note: The server needs to be configured only once, and it was configured during installation. You

should not change the directories after this configuration occurs.

1. Log on to SAS Profitability Management.
2. Select Edit » Server Configuration.

The Server Configuration window opens.

3. Click the General, Folders, and Metadata tabs, and then enter the required information.

E@ SAS Profitahility Management - Bank_Model

File | Edit “iew Actionz Help

J L 3 Remove... | |h-1|:u:|el: IEank_M-:u:IeI

Tr

@ &nalysiz Sethings...

s - =___m o
B8 Server Lanhguratian

Mame | Period o

j_,-/
fl& Server Configuration

General |F|:ulclers I Metadata I

Repasitory: | [2] Foundation

Model data: P Model

Select |

Daka version: |1

i Server Configuration

General Folders |Metadata|

iZreate OB |

=0l x|

SA5 scripks: | 1545 ProfitabilityManagement| Datatier) SASCode

Cubes: | C:15AS ProfitabilityManagement OLAPEr Cubes

Model mekadaka; I C:15AS ProfitabilityManagement|Datatier Models

il Server Configuration

General I Folders Metadata |

=0l x|

Model tree: I [Profitabilityfanagement/Models

(o]

Reports: I Feports




[Profitabilityfanagement/Models
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Edit the Properties of a Cube

To edit the properties for a cube, perform the following steps:

1.

2.

Activate the Transactions workspace, and then select a model.

Click Change analysis settings, or select Edit » Analysis Settings.

The Analysis Settings windows opens.

. Click the Periods tab to select which periods to include in the generated cube.

Note: The periods that you select to include in a cube must have been
previously selected for calculation when you calculated the model.

. Click the Measures tab to define the display format for numbers.

Note: You can also change the display format for numbers in the SAS
Profitability Management Web Reporting Client.

11



Generate a Cube

To generate a cube, perform one of the following steps:

. Activate the Reports workspace. Select a summary report, and then click
Generate cube, or select Actions ¥ Generate Cube.

. Follow the process to calculate a model. During that process, you can generate
a cube.

12



View a Cube (Summary Report)

. Open a summary report

. Drill into a summary report

. Suppress the display of blank content

. Select specific values to display

. Change the number of rows or columns that are displayed

. Change heading colors

. Format displayed numbers

. Insert a graph

. Save a view of a report

13



Custom Dimensions Table

A custom dimensions tables defines the dimensions of a transaction. A definition table must be loaded for each dimension

that will be used in the model and in the transaction tables. A custom dimensions table contains the following columns:

Position |[Name Maximum Length Description
The identifying value for the region; must be unique and match the
1 ID Char 32 . : . . )
dimension value fields in all transaction tables
2 L1 _Area Char 32 Top-level dimension member value (for example, EMEA)
3 L2_Country (Char 32 Second-level dimension member value (for example, Great Britain)
4 L3_State Char 32 Third-level dimension member value (for example, Sussex)
5 L4 City Char 32 Fourth-level dimension member value (for example, East Sussex)

In a custom dimensions table, consider the following rules:

. The first column is the key field.

. Subsequent fields are the dimensions in the order in which they appear in the table.

. Each column must have the length that is shown.

. The name of the column is arbitrary, but it must be a single word.

. The number of columns is arbitrary.

Notes:

. When transaction tables in different transaction table groups map to the same custom dimension table, then the
column names in the transaction tables must match. Otherwise, the table joins to create the OLAP cube will fail.

. Level names must unique across all dimensions. A difference in case does not count as a difference between names.

The following picture shows the mapping from a sample transaction table to different custom dimensions tables:

. Channel

. Customer

. Customer-Type

. Product

. Region

14




Transaction table

.

2006_0G1_Achual
2006_0G1_Achual
2006_0G1_Achual
2006_01_achual
2006_0G1_Achual

L e I P I ]

FReg_ 1078

AMT | Count |

Custom dimensions tables

IS[=] B3

=

AzzignmentRule

51

1 ATM_CHK_Check balance

L1_Channel

ATM
ERH

2006_C7_Actus gt
2006_071_aActu:
2005_01_Acty L1_Area L2 Country L3 State | L4 City 3
q 2005_01_Achy Azia Pacific Australia Australia Tate
10 2006_01_Actfe Azia Pacific Australia Australia Zetland
12 2006 (1) L1_CType | L2 CType L3 CType Al
13 2006_01. Buziness Retall Consumer Banking
14 2008_C1, 2 SRR Ruzinezz Small Rusiness Bankinn
L1_Product L2 Product
1 Credit Products B
Depogit Products b azs Market
m_buzz.Dim_customer :f.;ture and Fetired
. et
| L1_Type | L2_LastHame | L3_FirgtH ame ﬂ &l Business Enterprise
1 0oo1 Perzonal Browning Lee A Busi £ P .
M — - C P & |um. uzipess E= "“N“‘v

D | L1_Charnel
1 ATM AT
2 BRH ERH
3 CCT Call Center
4 D54 Direct Sales Agent - D5A
] EML Email
E EVE Events
7 IMT Internet
a hAsL b il
9 HOF tobile Phone
10 TEL Telebanking
11 AR

ki

Customer Dimensions Table

15




li'il_ ¥IEWTABLE: Pm_buzz.Dim_customer

[ L1_Type L2 LaztMame L3_FirztM ame ﬂ

1 0o Perzonal Browning Lee

2 Qaonz Perzonal Scarella Cynthia

3 000 Perzonal Bogzch Duane

4 aoog Perzonal Digarmallo b ark,

] Q0005 Perzonal Pennize Alana

E Q0006 Perzonal Gilbert Wicki

7 aoaoy Perzonal Ellizon David

__..f":’\: n0aog Fersonal Butle dward
18293 4 fal ight [l
18234 | 18255 Perzonal Yach
18295 | 18256 Perzonal Yarnell J
18296 | 18297 Perzonal Young J
18297 | 182938 Perzonal 'aung K.
18238 (182589 Perzonal Yu [l
18293 |18300 Perzonal Zhang E
18300 | 183M Perzonal Codere Mancy
18301 | MAA
1] I

Customer-Type Dimensions Table

li'il_ ¥IEWTABLE: Pm_buzz.Dim_custtype

o | L1_CType | LZ_CType L3 CType
1 RCE Buziness Retail Consumer Banking
2 SEBE Buziness Small Businezs Banking
3 FRE Perzonal Private Banking
4 LB Perzonal Onllne Banking
5 CPE Businesz Corporate Barnking
G bl b Buziness Retail Consumer Banking bl azs Market
f MRT Buziness Retail Consumer Banking b ature and Retired
g AFF Buziness Retail Consumer Banking Afflient
9 SBE Business Small Business Banking Small Buzsineszs Enterprize
10 MEE Buziness Small Businezs Banking bedium Business Enterprise
11 RFE Perzonal Private Banking Retail Private Banking
12 FEI Perzonal Private Banking Private Banking and [nvesting
13 WwER Perzsonal Private Banking Wealth M anagement
14 FRT Perzonal Private Banking Franchize Trust
15 “WEB Perzonal Onllne Banking Wieb Banking
16 EBF Perzonal Onllne Banking Electronic Bill Payments
17 hFM Business Carporate Banking Media Finance
18 AaGR Buziness Corparate Banking Agriculture
19 |45 Buziness Corparate Banking |mgtitutional Azset Services
20 HEC Buziness Corparate Banking Health Care
21 CRE Buziness Corparate Banking Commercial Real E state
22 STF Buziness Corparate Banking Structured Finance
23 IMB Buziness Corparate Banking |Fvestment Banking
24 Chk Buziness Corparate Banking Capital Markets
25 [ EY

1|

Product Dimensions Table

16




EE,_HI'IEWTABLE: Pm_buzz.Dim_produckt

o | L1_Product | L2_Product
1 CRP Credit Products
2 DEF Deposit Products
3 FEF Fee Bazed Products
4 aTtrF Other Products
] RCF Revolving Credit Products
G TFF Third Party Products
f SCH Credit Products Secured/Mortgages
g IICR Credit Products Un gecured
9 CHE. Deposit Products Checking
10 REC Deposit Products Recurring
11 SAN Deposit Products Savings
12 TR Depozit Products Term
13 CRC Revolving Credit Products Credit Cards
14 oD Revolving Credit Products Owerdrafts
15 [ EY
a |

Region Dimensions Table

li'il_ ¥IEWTABLE: Pm_buzz.Dim_region

D | Llaea | L2 Counhy L3_State L4_City
1 Reg_0 Azia Pacific Australia Auztralia Tate
2 Feg 1 Azia Pacific Auztralia Auztralia Zetland
3 FReg 10 Azia Pacific Hong K.ong Hong Kong K.owloon Tonig
4 Req_100 EMEA [Ereat Britain Suzzey East Suzzex
5 Reg_1000 1545w 154 Califarnia kch Camp Pendleton
G FReg 1001 158, Shwf 54 California hizzion Wigjo
f Reg 1002 158, Shwf 54 California b ountain Wiew
g FReg 1003 158, Shwf 54 California Mewport Beach
9 Reg 1004 158, Shf 154 California Dakland
/)“\ Req_100 154, 54 Californ Ocegpsde
T 2SN o I IE]
1130 eq 99 EMEA reat Britain Suzzey athgate
1131 |Reg 9330 158, Shwf 54 California Lafayette
1132 |Reg_ 991 158, Shwf 54 California Laguna Beach
1133 |Reg 992 158, Shwf 54 California Laguna Hills
1134 |Reg_933 1545w 154 Califarnia Laguna Miguel
1135 |Reg 994 158, Shwf 54 California Lake Forest
1136 |Reg 3595 158, Shwf 54 California Lexington Park,
1137 |Req 996 158, Shwf 54 California Loz Angeles
1138 |Reg_ 997 1SA_ShWw ISA Califarnia M adera
1139 |Reqg_ 993 158, Shwf 54 California b anhattan Beach
1140 [FReg 933 1545w 154 California b arch Afb
1141 [MAA

1

o
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Drill into a Detail Report

« Drill by columns

. Drill by rows
Drill by Columns

Drill down into the columns to see more detail in the period dimension.

Orill Path: # X Applied Filters
B views Dataw Properties £ X
Click to drill dowen into the year [T vear ™ 2006
L1_Profit LZ_ Profit
Drill Path: # X Applied Filters:

L1_Year = 2006

 view> Dataw Properties

Click to expand
LZ CQuarter Elzoos_m\‘lilzoos_qz FFE 2006 03 [#HF2
Click to drill down A

L1_Profit | L2 _Profit

Credit Card
interest

Income 4. 707 3ED 5.2193E9 5.7534E9 &

Il Interest 1 nan

be
X

Crill Path:

Click to drill ot ———mel1_Year = 2006 = 200&_0Q1

Drill by Rows

Drill down into the rows to see more detail about the contributing costs.
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Total Mon Interest Income 2861.28 2575.15 366.49

Provision For Losses 465.46 418.91  515.11
[=1[#] Cost ta
[=][3] Direct Provide SRR e 49.34 50,75  43.83
Product
[#[E] cost to Sustain Business 84.95 6048 8323
e ElBlovD  CCT_OVD_Inquiry 245.52 11111 238.27
CCcT [
[=][3] Cost to T
. R
Ataulie E0E 0.00 000 0.0
(3 3 T 0.00 0.00  0.00
[=1[3] Relationship ceT
Management [=][T] Cost to B 5.26 2.34 5.15
Retin i@ vaL EIEIOTP  MAL_OTP_Communication 612.87 49976 &73.66
[#[3] Cost to Serve 0.00 .00 0,00
[#[3 Cost to Sustain Business 254.86 181.45 249.43
[=] 3 Sales and [#I[3] Cost to Retain 0.00 0,00 0,00
tarketing
Effort [# [ Cost to Sustain Business 139,81 241.93  3I.90
[#1[31 Servicing Effort 169.92 120,98  166.47
Total Mon Interest Expense 2228.89 1687.23 2303829
Met Contribution 21355.31 19538.54 23791 .62
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Open a Detail Report

Use the SAS Profitability Management Web Reporting Client to select a detail report for viewing. The report is viewed with the

SAS Web OLAP Viewer. To view a detail report, perform the following steps:

1. Log on to the SAS Profitability Management Web Reporting Client.

User IDs and passwords were established during installation. The exact URL to use depends on your server installation.

A sample URL is the following:

http://profitmgmt:8080/SASProfitability/LogonCreate.do

SAS Profitability Management

EEEN dser name:

Password:

Log On

2. Click the Detail Reports tab.
3. Select a model.
4. Select the dimension to view.

5. Specify a value of the dimension to search for, and then click View.

Note: The text that is entered into the Search For field is case sensitive.

Log Off pmuser! |

Profitability Management - Detailed Reports §Sas.

Click the Detailed Reports tah

Select a model —» Model: | Bank_Model =l
Select the dimension to view ———— Wiew By CUSTID v|
CHAMMEL
CUSTTYPE
PRODUCT
REGION
Specify a value L Search For: 10025
View
[~
|@ Log O I_l_l_l_l_li‘—_g Local intranet i

6. The detail report is displayed in the SAS Web OLAP Viewer.
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a SAS Web OLAFP Yiewer for Java - Microzoft Internet Explorer provided by 5AS

aProfitability Management

SAS Web OLAP Viewer - Untitled Data Exploration

File= Data~  Wieww %Navigatnr & Bookmarks il T B O i il @ [ &
I Query 3
selected Items: Drill Path: # ¥ | Applied Filters:
E4E5 Rows =
T Load_ReportHierarchySet
Elﬁ Columns B vieww Dataw  Properties 2 X
E----ELn:uan:l_litlirnensin:nn_F'erin:u:I
E123 Slicer L1_Year []2006
~ERvALUE = L1_Profit L2_Profit
el 2 [RET Credit Card interest Income FEZ8T .97 .
Available Items:
9 PM_sasdemol 159579658545 |- Interest Income | Loan Interest Income 1824856

-z LLE Mortgages Income

-T2 Load_Dimension_Period
----"—'_.Lnad_RepnrtHierarchySet vt miEiEsE Inzems 2877735

-, Load_Dimension_Channel Savings Interest Payments -10170.8

~TLoad_Dimension_cCustType . )
- LI Interest Expense | Certificates of Deposit Payments

Apply | Restore | Investment Securities Payments

Total Interest Expensze -10170.8 v|
4| i

|
|@ |a@vascrpt: woid[0] I_ I_ I_ I_ I_ |“-_J Local intranet o
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Driver Formula

An assignment rule uses its driver formula in a calculation is based on whether the
behavior table contains a unit value or a total value.

Unit Value

When a row in a behavior table contains a unit value, the driver formula
calculates the number of units that are involved in each transaction that is
selected by the selection criteria. Then, the cost per transaction (value) is
determined by multiplying the number of units by the unit cost (in the behavior
table) of the transaction.

Show an example

Total Value

When a row in a behavior table contains a total value, the driver formula
calculates the number of units that are involved in each transaction that is
selected by the selection criteria. Then, the cost per transaction is determined
in the following way:

1. The total number of units for all transactions (selected by the selection
criteria) is calculated by adding the number of units (as determined by
the driver formula) for each transaction (selected by the selection
criteria).

2. The cost per unit is calculated by dividing the total value (in the row in
the behavior table) by the total number of units.

3. The cost for each transaction (value) is calculated by multiplying the

cost per unit by the number of units (as determined by the driver
formula) for that transaction.

Show an example
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Driver Formula: Total Value

In the following picture, you can see:

@ Time

1. The driver formula is: Count*.05 + AMT*.01.

2. The driver quantity for the first transaction is 0.56.

1 2006_01_Achu.

A2 count |3 aMT |
T Gl

I I
Count*.08 + AMT*.01

1 *05 +

21 *01 =56

3. The cost per transaction (value) for the first transaction is 48.692101732.

Note: If you divide the value by the driver quantity for each of these three transactions, you get the same answer (rounded for the purpose of illustration)

o 48.6921/0.56 = 86.95
o 25.2155/0.29 = 86.95

o 21.7375/0.25=86.95

This quantity, 86.95, is the price per unit. So, the driver quantity (which represents the number of units) multiplied by the price per unit equals value (cost per transaction)

Rule

I Properties - ATM_CHK_Requests

General |

I ame:

[ATM_CHE_Requests

Azzigh bo bransactions from table group:

[ sBM Cost

with rows matching selection criteria;

Using driver farmula:

IsChildOfCharnel, [DIM_CHANMELLIATMT AND IsChildOf(Product,
[DIM_PRODUCT][Deposit ProductsL [CHE]]

(__ Behavior table
Count * .05 +4MT*01
(= II\——”J @ Time @ 1D @ Name @ AssignmentBule @/ﬂ;aw Unll\l"alue

1 1 [2005 01 _Actual _ 21055 ATM_CHK_Requests ATM_CHE_Requests I\ TE7743T. 8288

I 2 2006_| Q1 Actual 20@3 ATHM_CHE_Check balance ATM_CHE_Check balance

| —] : <

o w N AVAA A 4 a8

Transaction talble (before calculation)
| Tiy[ue I8 CustiD /% Product/®y CustTypel. Region |/ Channel i} AMT |z Count [/ AgsignmentBule
1 2006_01_4ctual - 00005 CHK WEM Reg_249 ATM a1 1 ATM_CHEK_Requests
2 2006_01_gctual - 00008 CHK -EBP Reg_281 ATM 24 1 ATM_CHK_Requests Cost for this transaction
3 2006, Q1_P-‘«ctual 00025 CHK Reg_523 ATM 20 1 ATM_CHK_Requests
= =006 ﬁctw‘ UDD%B = Heg_/1 S AIE' o _ QBL -~ __1“ ATM_.CUK__HE?:_C]-L-AES[S Number of units:
- _ P - A et Count*.05 + AMT*.01 ,
Tranzaction table (after calculation) 1*.05 + 51*.01 = .56 |
@@@ AssignmentRule |/ Channel @@ I  CustiD |/ CustType |/ Product [/ Region |/ Time @Dﬁuer@uan‘li‘lyﬁ@ Value L Behavior
1 | 51 %TM_CHE_Requests ATM I 1 (/0005 'wiEM CHE Reg_#43 2006_01_Actual 056" | 48692101732 21086
2 24 ATM_CHE_Requests ATH | ?GDDDS EEP CHE Reg_281 2006_07_Actual 023 | 25215552682 21066
3 207ATM_CHE_Requests AT N //a0025 WEE CHK Req 523 2006_07_Actual 0.25  21.737545416 21066
4 21 ATM_CHE_Check balance AT —1 L A00S wEM CHEK. Req 843 2006_01_aActual 1 1B9.30408038 22021
e '“"«IM‘:EI;IJ(-—‘“mok balaps—"—4Th T WEM— CHE " Penpun— 000G 14 - - CUUERT TH0058
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Driver Formula: Unit Value

In the following picture, you can see:

1. The driver formula isCount.

2. The driver quantity for the first transaction is 51.

3. The cost per transaction (value) for the first transaction is 73.9036050297. This represents the number of units (51) multiplied by the unit value from the behavior table
(1.4490902947).

Rle

EE Froperties - ATM_CHE_ Check balance

General |

Mame:

[TH_CHK_Check balance

Aigzigh bo ransactions from table group:

[E 4B Cost

“with rows matching selection criteria:

Using driver formula;

AzzignmentRule = ATM_CHE_Check balance'

So, the driver quantity (which represents the number of units) multiplied by the price per unit equals value (cost per transaction).

Behavior table
I Caunt LA Time A D A Name 14 AszsignmentRule |z TotaMake @ﬁr:il\faﬂ
1 [2006_01_Actual 20003 ATM_CHE_Check balance ATM_CHE_Check balance '\ 1.4430302347]7
2 | 2005 Q1 Actual 20003 ATM_CHK Deposits ATM_CHK_Deposits . O7e0088T6
Thang e i D R e T ~ s
w W\/\ e K De’ ~
Transacton table (before calcula
@ Time @ CustiD mducl@ EuslType@ Region @ Channel @ AMT @ Count @ AssignmentBule
1 2006_G1_Actual 00005 CHE WEM Reg_543 ATM 1 51  ATM_CHK_Requests
2 2006_G1_aActual 00003 CHE EBF Reg_281 ATHM 1 24 ATM_CHK_Requests Cost for this trans_al:ticm:
3 200601 Actual 00025 CHE WEE Feg 523 ATM 1 20 ATM_CHK_Requests Count ¥ Unitvalue
3 L2005 01 _Actu=—- 00023 ~ MRT Feg 12— ATM —_ 1 ATM_CHE Fequests =
- o i T S R ey Ve . Number of units = Count
|
Transaction table {after calculation) . |
Kzl AMT [/ AssignmentRule |4 Channel |i) ﬁunl\‘-.l@ CustD |/ CustType |/ Product |2 Region |/ Time izl Driver Quantity |2) Value |{) lBehaviu
1 ATM_CHE_Hequests AT I 51 ¢ WEM CHE Feg 843 2006_01_aActual 51 739036050257 20003
2 ATM_CHK_Requests ATH | EEF CHE Reg 281 2006_01_Actual
3 ATM_CHE_Requests AT WEB CHE Feg 523 2006_01_Actual
4 51: ATM_CHE_Check balance AT WEM CHE Feg_ 543 2006_G1_aActual 1 169.30408038 : 22021
B AIM‘:EW,fmapkb_a]am—-- ATk — _WEM e [HE P pa nnng_‘__g)]__.a--"' __’ - CangFRe DDDEB I |
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Driver Quantity

Driver quantity is the number of units calculated by the driver formula. The calculation
is based on whether the behavior table row that is accessed by an assignment rule
contains a unit value or a total value.

Unit Value

When a row in a behavior table contains a unit value, the driver formula
calculates the number of units that are involved in each transaction that is
selected by the selection criteria. The number of units appears in the Driver
guantity field. Then, the cost per transaction (value) is determined by
multiplying the number of units (driver quantity) by the unit cost (in the
behavior table) of the transaction.

Show an example

Total Value

When a row in a behavior table contains a total value, the driver formula
calculates the number of units that are involved in each transaction that is
selected by the selection criteria. Then, the cost per transaction is determined
in the following way:

1. The total number of units for all transactions (selected by the selection
criteria) is calculated by adding the number of units (as determined by
the driver formula) for each transaction (selected by the selection
criteria). The number of units for each transaction appears in the
Driver quantity field.

2. The cost per unit is calculated by dividing the total value (in the row in
the behavior table) by the total number of units.

3. The cost for each transaction (value) is calculated by multiplying the

cost per unit by the number of units (as determined by the driver
formula) for that transaction.

Show an example
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Edit a Model
To edit a model, perform the following steps:

1. Select File ¥ Organize Models.
The Organize Models window opens.
2. Select a model.
3. Click Properties.
4. Edit the model.
5. To preview the data on the General, Behavior Table, Dimensions, and Reports tabs, click Preview.

The Preview window opens.

Note: If you change the report hierarchy or report layout, you have to regenerate any cubes (summary reports) that have already been
generated.

2 sAS Profitability Management - BabyBank -0l x|
File Edit W¥iew Actions Help

Select File » Organize Models —»

|,&| a |Model: IBabyBank

. & Organize Models
Prope It

Models:

Exit -
Select a model — T
W TestBank 4

Click Properties > sis settings...
_ﬁl_____——————_ — e

~1al x|

| Analysiz | Data Location I Behavior Table I Dimensions | Reports I

o
m
[

Mame: I BabyBank
Edit the maodel —
Description:
Time dimension; |@Dm_pERIQD | Select... | Preview... |
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Export a Rule Association Table

1. Activate the Behaviors workspace, and then select the model from which you
want to export the rule associations.

2. Select Actions ¥ Export Associations.
The Export Associations window opens.

3. Name the export table.

4. Click Select to select a library in which to store the export table.
The Select Table window opens. Select a library, and then click OK.

5. Click OK.
Related Topics:

. Import a rule association table
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Export a Rule Definition Table

1. Activate the Rules workspace, and then select the model from which you want
to export the rule definitions.

2. Select Actions k Export Assignment Rules.
The Export Rules window opens.

3. Name the export table.

4. Click Select to select a library in which to store the export table.
The Select Table window opens. Select a library, and then click OK.

5. Click OK.
Related Topics:

. Import a rule definition table
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Filter by the Value of One or More Dimensions

You can select all rows in a transaction table that have one or more columns whose value matches (or doesn't match) values

in dimension tables.

In the following picture, the selection criterion IsChildOf(Channel, '[DIM_CHANNEL].[ATM]") AND IsChildOf(Product,
'[IDIM_PRODUCT].[Deposit Products].[CHK]') selects the first several rows in the transaction table:

Fule
IE Properties - ATM_CHK_Requests

General I

M ame:
|ATM_CHK_Riequests

Aszzign to tranzactions from table group:
(¥ ABMCast

Product Dimension

With rows matching selection criteria:
|zChildOf[Chantel, Y01 CHAMMEL][ATHM]:

ChildDf[Product, = ¥YIEWTABLE: Buzzstar.Dim_produck

Dit_PRODUCT].[Deposit Pdeuctsj.[EHK [ | L1_Product | L2 Product -
Using driver farmula: \ 1 CRF Credit Products
L WEL o - — 2 DEF Deposit Products
II:':'L"'It 05 +AMT™.01 T |cHK Deposit Products Checking
—
— _ 4~ |0TP Other Products

B \GCP

Peyolyir Tosdit Prode

Transaction -
i Time % CustiD {ﬁ Pmdu-::.t.@} CustType|/s. Region [ Channel|lz) AMT [z} Count
1 2006_01_Actual £ 00005 CHE. WE Reg_ 843 ATM 51 1
2 2006_01_Actual 00003 CHE. EEP Reg_281 ATM 24 1
3 2006_01_Actual | 00025 CHE. “WEB Reg 523 ATM 20 1
|4 L0068 01 _Actus—00028  oW=——" MRT - Reg 12~ |ATM ) .
T A e i » S o -

Notice that the IsChildOf property allows you to select from any point in a dimension hierarchy tree, and all children of that

hierarchy are filtered as a "Yes" value.
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Filter by Matching a Behavior Table Field and a Transaction Table Field

The match behavior operator enables you to do a field comparison between the behavior table and a transaction table. The

selection criteria are met when the value of every matching column in the transaction table row equals the value of the corresponding
matching column in the behavior table row.

For example, “Product” in a transaction table can have a corresponding matching column “Product” in the behavior table.

Both text and numeric column types are supported for field matching. You can combine multiple match behaviors with AND.

i Add Assignment Rule I ]
Rule Harme:
IMatchEehaviur

Step 1: Select a table group:
[ ABMCast | v]

Step 2: Set the selection crteria:
M atchCalumng T ranzaction[Praduct [3B ehaviorlProduct]) ;l [efine. .. I

L

Step 3: Define the driver formula:

Count * .03 +AMT*.01 \ﬁf‘"_"‘ﬁ-.,‘ :! LI Transaction table

LA Time Ly Eustl[{!’;ﬁ}. Pmductl’i‘f;-, CustType|’s Region |/ Channel [iZ8 AMT |z} Count

1 2006_G1_Actual 00005 \J;HK __,)ﬁ*.-"EM Feg 849 ATM 51
2 2006_01_Actual 00008 EﬁE_F“aEQP Reg_281 AT 24 1
3 2006_091_Actual 00025 SN WEB"‘C:;-:;:._ Reg 523 AT 20 1
4 le006 01 _Actust—00028 et MRT ST Reg 12 ATM 3 1
e e T i L e - h i T,

e,

a,;--@ehaviur takle

Es Preview - BEEHAVIOR

-,
.

Table Columns  Table Data |

Presiewing firzt 1000 records [if more than 1000 are prezent)

L2 Time |{} 1D |{:}. Mame | 3 AszsignmentPiule |Ez3}TutaI'\-"alue | ifzd) Unifi"al.u.g \45}, Product =

200604 _Actual 20004 ATHM_CHE_Deposits b atchB ebavior 0.0 2.1 85084235857?&355 CHE

2006_04_Actual | 20005 ATH_CHE_Fund Transfer t atchB ehavior na 9.832989430989614E54 | SAY

2006 04 Actual 20008 ATHM_CHE_\withdrawals b atchB ehavior 0.0 [.0046523841 78538148 MH‘*EHK i

2006_014_Actual | 20007 AT RC_wWithdrawals MatchB ehavior 0.0 [,OM 870193508075186 | CRC —
== al | 200 ngits E - nn 1237E-4
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Filter by Numeric Value
Matching Values

You can select all rows in a transaction table that have one or more columns whose numeric value matches (or doesn't
match) a specified value.

In the following picture, the selection criterion Complaints > 10 selects the first two rows in the transaction table:

Fule

KX Properties - ATM_CHK_Requests

General |

WETER
|ATM_CHK_Depasits
Azzign to ranzactions from table group:
(5 ABM Cost |

With raws matching selection criteria:

Complaints > 10

Transaction table

Uistrg dlfver s Ii'E,_ YIEWTABLE: Buzzstar.Callcenter_q4b T _

Count .05 +AM Tire | CustD | Product | CustType | Region | Channel | Communication | / Complaints | I

196 | 2006_G4_Budget 03325  CHE  WEM Reg 71 CCT 10 11

197 | 2006_04 Budoet 05335  CHE.  EBP Reg 23 CCT g 12

198 | 2006_(J4 Budget 05363  CHK  EBP Reg_Z22 CCT = ]

199 | 2006_04_Budget 09427 CHE.  Mab Reg 86 CCT 2 0

200 | Z2006_4_Budget 05452  CHK  MRT Reg 43 CCT 1 2

A5 ne453 v RPE N | 1 0

: = n

Matching Behavior

You can create a rule that matches fields between columns in the behavior table and the transaction tables. The
match Behavior operator enables you to create one rule for one type of field matching for multiple behaviors, which
makes modeling much easier.
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Filter by Text Value

Matching Values

You can select all rows in a transaction table that have one or more columns whose text value matches (or doesn't match)
a string.

In the following picture, the selection criterion AssignmentRule="ATM_CHK_Check balance' selects the first several
rows in the transaction table:

i Add Assignment Rule M= E3

M amne:
INEW_H Ll

Azgign o tranzactions from table group:

o vicw T — e FEE

_"".I:\_E With rows matching selection criteria: E'MTE-I | count -Il!.r"lf_.,'TM Elilﬁ.is::g_::;knttz:ﬁ:;\ ﬂ

2 20 AzzignmentRule = "4TM_CHFK_Check balance' - Define. .. x| 1 ﬁThd:EHK:Eheck balance

3 20 lI 20 1| ATh_CHEK_Check balance

4 20 -\_\_EBT\__‘_‘—\—\_\_\__-I\_ ATh_CHK_Check balance

5 20 Using driver formula; 93 'I*.L-’-'-.T M_CHE_Check balance

E 20 AMT ;I Celect I 142 1| &T_CHE_Check balance

7 20 186 1| ATM_CHE_Check balance

] 20 ll 240 1| ATM_CHE_Check balance

20 26 1| ATM_CHE~ Check balan
.-?’QT__-;-: ] 4 | Cancel | /\/\ TM_  ba \
\ S

In the following picture, the more complicated selection criterion AssignmentRule="ATM_CHK_Check balance' OR
AssignmentRule="TEL_SAV_Fund Transfer selects rows at the beginning of the transaction table and rows at the end of
the transaction table:
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i Add Aszzignment Rule M= B4

Time

1

2006_G1_Achk,

2006_G1_Act,

2006_G1_Ach,

2006_[7_Ach.

2006_[7_Ach.

2006_[7_Ach.

2006_G1_Ach.

2
3
4
]
G
7
g

2006_G1_Achk,

AN

\/
§ZEN

99254

2006 At
[~

Q0E_GQ_Act:

99255

2006_G1_Ach.

39256

2006_01_Ach,

39257

2006_G1_Ach,

39258

2006_7_Ach,

99253

2006_[7_Ach.

99260

M ame:

II::uzz_N ew_Rule

Azzign to trangactions from table group:

|Ej Bank_Transactions

Select... L

With rows matching selection criteria;

Uzing driver farmula;

AzzignmentBule = 'ATM CHE _Check balance' =
0R AzsignmentRule = 'TEL_SAY_Fund Transfer'

AT

;I Define. .. I

2006_01_Actiemr

93261

2006_01 _actual

99262

2006_01 _actual

39263

2006_G71_Actual

33264

2006_G71_Actual

39265

2006_01_Actual

99266

d

Jdl

2006_01_Actual

LI
(] Cancel |
rJrr Pl LGl P i | TTE _LrT T Ll 1)
17985 SAN EEP Reg_143 TEL 1471
18005 SAN FEI Reg_ 531 TEL 5289
18153 SaN WEB Reg_74 TEL 5903
18251 SAN WEM Reg_E&3 TEL 4472
18301 SaN AFF Reg_1038 TEL 21739
18301 SaN RFE Reg_281 TEL E147

_;_;_;_;_;_n._;_;_;_ngé_;

AzzignmentBule
k_CHF_Check balance
ATM_CHFE_Check balance
ATM_CHE_Check balance
ATh_CHK_Check balance
ATh_CHK_Check balance
ATh_CHK_Check balance
ATHM_CHF_Check balance
ATM_CHFK_Check balance

TEL_SAY_Fund Transfer
TEL_SAY_Fund Transfer
TEL_SAY_Fund Transfer
TEL_SaAY_Fund Transfer
TEL_SAY_Fund Transfer
TEL_SAY_Fund Transfer
TEL_SAY_Fund Transfer
TEL_SAY_Fund Transfer
TEL_SAY_Fund Transfer
TEL_SAY_Fund Transfer
TEL_SaAY_Fund Transfer

\Q_S.-'-‘-.\-’_Fund Transfer /—'

+

Matching Behavior

You can create a rule that matches fields between columns in the behavior table and the transaction tables. The match

Behavior operator enables you to create one rule for one type of field matching for multiple behaviors, which makes

modeling much easier.
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‘4— H i ‘2. Set Up the Environment

. ldentify input and output directories to SAS Profitability Management

. Import tables into the input directory

. Add users

. Configure the server
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Identify Input and Output Directories to SAS Profitability
Management

This process needs to be performed for both the input and output directories.

1. Log on to the SAS Management Console.
The main window opens.

2. Select the Foundation repository.

3. Expand Data Library Manager.

4. Right-click SAS Libraries.

5. Click New Library.
The New Library Wizard opens.

6. Select the type of library to be created (for example, SAS Base Engine Library),
and then click Next.

7. Name the library, and then click Next.
8. Type a libref name (the name you use to refer to the library).
The libref name must be less than eight characters.
9. Specify BASE as the engine type.
10. Specify the library directory path, and then click Next.
11. Select SASMain as the server where the library is to be assigned.
12. Click Next, and then click Finish.

13. Select View ¥ Refresh to see the library listed.
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Identify Input and Output Directories to SAS Profitability Management
This process needs to be performed for both the input and output directories.

1. Log on to the SAS Management Console.

The main window opens.

2. Select the Foundation repository.

3. Expand Data Library Manager.

4. Right-click SAS Libraries.

5. Click New Library.

The New Library Wizard opens.

T 5A5 Management Console - ABMMoe =] B3
File Edit “ew Acktions Tools Roadmaps Help
» | X | &
Select Foundation —fepestory: JI Foundation =l
@ SAS Management Console = | Eniirne | Description |
I.J—]—Q Environment Managerment ...OLEDE -
: BASE
. BASE
Expand Data Library Manager  BASE
Right-click SAS Libraries ...BASE
BASE
BASE
. BASE
Click New Library _... BASE
o Properties _=..BAZE LI
|1T-r ohjec I_ﬁ zasadim as Unrestricted Iﬁ@ abmmoe.na.sas.cotm | 8561

6. Select the type of library to be created (for example, SAS Base Engine Library), and then click Next.

7. Name the library, and then click Next.
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Mew Library Wizard | x| |

Selectthe type of libran you wish to define.

. [=H__ | Resource Templates

. IJ:'I—J Libraries

' ___| Databaze Libraries

__| Enterprize Applications Libraries
m Genetic Library
m Pre-azsighed Libraty

select type of library = | SAS Libraries

! |—_ aze Engine Library

Mew Library Wizard | x| |

| Bpecifi the name and description for the new SAS Base Engine Librany.

Marmne the library —————# Name: firput Diectory]

"

Description:

Help | Cancel = Back Mext = Firizh

8. Type a libref name (the name you use to refer to the library).
The libref name must be less than eight characters.
9. Specify BASE as the engine type.
10. Specify the library directory path, and then click Next.
11. Select SASMain as the server where the library is to be assigned.
12. Click Next, and then click Finish.

13. Select View k Refresh to see the library listed.
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Mew Library Wizard | x| |

= Enterthe following librar properties.

Type a libref — 7 ——#Likret IINF‘LIT
. . - .
Specify engine type ——i——s-Engine:  [Base =1
[ Enable WebDay Support
S
M~ Content Server: I(Seleu:t Cne) LI
specify library directory path ————s=— Path Specification;  Avsilable tems: Selected itemms:
¥

= COProgram Files u - |

—y CTest_Procinfomap

=i C:EAS'IPrDﬁtabilityManE,' "'*"'l

Mew Library Wizard Ed |
—_—

Selectthe SAS semner(s) where this librany is to he assigned. (Optional)

:‘f S&SMain - SASISHARE Server ;l
Select SASMain —

[ ]

Help | Cancel = Back Mlexdt = izt |
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Import Tables into the Input Directory

After identifying the input directory to SAS, you must import the input tables into the
input directory using SAS Management Console.

Note: Even if the input tables are already in the input directory, you must perform
these steps to identify the tables to SAS. And, if you modify the input tables
subsequently, you must reimport them so that the metadata that is maintained by
SAS Management Console is updated.

To import tables, perform the following steps:

1. Log on to the SAS Management Console.
The main window opens.
2. Select the Foundation repository.
3. Expand Data Library Manager.
4. Expand SAS Libraries.
5. Select the input library.
6. Select Actions k Import Tables.
The Connect to SAS window opens.
7. Select SASMain as the SAS server, and then log on to SASMain.
8. Verify that the input library is correct, and then click Next.
9. Select the tables to be imported, and then click Next.

Note: The name of a SAS table cannot contain a blank space or exceed 32
characters.

10. View the summary of which tables are to be imported, and then click Finish.
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Import Tables into the Input Directory

After identifying the input directory to SAS, you must import the input tables into the input directory using SAS Management
Console.

Note: Even if the input tables are already in the input directory, you must perform these steps to identify the tables to SAS. And, if
you modify the input tables subsequently, you must reimport them so that the metadata that is maintained by SAS Management
Console is updated.

To import tables, perform the following steps:
1. Log on to the SAS Management Console.
The main window opens.
2. Select the Foundation repository.
3. Expand Data Library Manager.
4. Expand SAS Libraries.

5. Select the input library.

Y. SAS Management Conzole - abmmoe

=] B3

File Edit “iew Actions Toolz Roadmap: Help
& | X |
Select Feundation W’I" Foundation H
T e AT T T G T T Tt ;I — I Descrstion I =" I

--Q:i Bl Mananer

e

Expand Data Library Manager
Expand SAS Libraries

@Data Library Manager

= | SAS Libraries

(- (=] A_Big_Bank_End

- (2] A_Big_Bank_Start

- (2] A Big Bark Start SAS Dat
- (2P AEM SEL - ABMBLUE
- (=) B_Big_Bark_End

- (2P B_Big_Bark_Start
- (28 Buzz_PM_input

- [2P Buzz_PM_Out

(- (2P Globus Data hart _|;|
|

Select the input library

Rl

|E| object(=) Iﬁ sazadm as Unrestricted

Iﬁ@ abmmoe.na zas . cotm | 8561

6. Select Actions ¥ Import Tables.
The Connect to SAS window opens.

7. Select SASMain as the SAS server, and then log on to SASMain.
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% SAS Management Conzole |

File Edit “iew | Action: Tools Hoadmaps Help

Select Import Tables

‘,E Import Tables. ..
Display Libname. .

Repositary: Irl F ~
oo o8 Edit Azsignments. . T — T _:
'"g'i Bl Mt Rerame Matme Description Falder
=0 Data L

=[] SAS Libraries |
i [ ——
_ , Connect to SAS |
e : :
' 4 We need to determine how to get to your source data. Specify the
(=P 4 - SAS Server to use to connect to your data.
S@El
o900 |:
Select SASMain oz e AP - it
E
E \
E" {
4 |
IEI ohject(=] I \

‘

Helgp Cancel = Eack | Mext = I FlE]

8. Verify that the input library is correct, and then click Next.

Select a SAS Library |
Selectthe SAS library thatwill point to the tables yvou are
importing.
ﬁ S&A5 Library:  |BAMNKEAE LI [Ew
‘ ~Library details
Werify the input library o Libref: | SEMlAEIE
Engine: IE‘-Q'-SE

Pathy  |CI\SASPM_BFriE

Edlit

[ Enable case-sensitive DEMS ohject names

" Enable special characters within DEMS ohject names

Help | Cancel = Back | Mext = I FEiriEh

9. Select the tables to be imported, and then click Next.
Note: The name of a SAS table cannot contain a blank space or exceed 32 characters.

10. View the summary of which tables are to be imported, and then click Finish.
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Define Tables B |

Click and highlight the tables vou want to select from this data
SOUrCE.

~=elect Takhles
Select the tables
to he imported

| Select All Tables I

Select Mone |

Help | Cancel = Back Mext = FriEh
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Rule Association Table

A rule association table associates rules with behaviors. Because an assignment rule selects rows from the
transaction tables in a transaction table group, the ultimate effect of a rule association table is associating
each behavior with a set of rows. A rule association table contains the following columns:

Name Maximum Length Description

BehaviorlD Char 32 The identifying value for the behavior

BehaviorName Char 255 Optional field; the name of the behavior

Table Group Char 64 Defined transaction table group for the rule that is applied
AssignmentRule  |Char 64 ;r;edglame for the assignment rule; must be unique within the

In a rule association table, consider the following rules:

. The columns must appear in the order that is shown.

. The columns must have the length that is shown.

. The order of the columns is arbitrary.

. The column name is arbitrary.

. If any column is blank, it is an error and the row is not imported.

. If the assignment rule name is not found, it is an error and the row is not imported.

. If the table group name is not found, it is an error and the row is not imported.

. If an association already exists for a behavior, the new association in the import table replaces the

existing association.

The following picture shows a sample rule association table that can be imported into a model.
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Associate an assignment rule with a behavior

.

L

,{5}. Behaviodd @ BehaviorN ame {3} T ableGroup {3} AzzignmentHule
1 10001 Credit Card interest [ncome Revenue Credit Card interest [ncome
2 10002 Loan Interest lncome Revenue Loan Interest Income
3 10003 Mortgages Income Revenue b artgages: Income
4 1100 Savings Interest Pavments Revenue Savings Interest Payments
L7 11002 Certificates of Deposit Payments Revenue Certificates of Deposit Payments
b 11003 Invesztment Securitiez Payments Revenue [rvvestment Securities Payments
7 1200 Credit Card Fees Revenue Credit Card Fees
1 Jevenue f\\\j ATM Fees . —
=3 ) t ou \/\,/
_ _'I-s state mm_ls\)/eme /‘5
MaL_CRC_Deliver Card and PIN ABMCost MAL_CRC_Deliver Card and PIN.-
Mal CRC_|zzue Bill penodically ABMMCogt tal CRC |zzue Bill periodically
247 | 23041 Mal 0D _lzsue statement ABMCost tal 0D _lzsue statement
248 | 23042 MAL_REC_|ssue Debit card ABMCost tal_REC_|zzue Debit card
249 | 23043 MAL_REC_|ssue statement ABMCost tal_REC_|zsue statement
260 | 23044 MAL_SAY_|zsue check book ABMCost Mal_Say lzzue check book
2h1 | 23045 MAL_SAY_|zzue Debit card ABMCoszt Mal_Say lzzue Dehit card
262 | 23046 MAL_SAN_[zzue statement ABMCozt Mal_Sal lzzue statement
2603 | 23047 MAL_SCR_|zsue statement ABMCozt tal_SCR_|zzue statement
2h4 | 23048 MAL_TRM_lzzue Debit card ABMCozt tal_TRM_lzzue Debit card
2hh | 23049 MAL_TRM_lzsue statement ABMCoszt tal_TRM_|zzue statement
256 | 23080 Mal_UCR_lzsue statement ABMCoszt tal_IICR_lzsue statement
2587 | 23051 IMT_CHE.,_Download Application ABMCozt IMT_CHF._Download Applicatian
258 (23082 IMT_CRC_Download Application ABMCozt IMT_CRC_Download Applicatian
209 (23053 IMT_FEP_Download Application ABMCozt IMT_FBF_Download &pplication
260 | 23054 IMT_0%D_Download Application ABMCogt IMT_O%D_Download Application
261 | 23055 INT_REC_Download Application AR Cost INT_REC_Download Application
262 | 23056 INT_S5a% Download Application AR Cost IMT_S5&%_Download Application
263 | 23057 INT_SCR_Download Application AR Cost INT_SCR_Download Application
264 | 23058 INT_TPF_Download Application ABMCost IMT_TPP_Download Application
265 | 23059 INT_TRM_Download Application ABMCost IMT_TRM_Download Application
266 | 23060 INT_UCR_Download Application ABMCost IMT_UCR_Download Application
267 | 23061 Morne_Mone_Mone ABMMCogt Cost to Sustain Buziness

|ﬂ [Unknown] connected to localkost

Wl

Related Topics:

Import a rule definition table

Import a rule association table

Rule definition table
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Rule Definition Table
An assignment rule associates rows in a group of transaction tables with behaviors. An assignment rule:

. is associated with one or more rows in a behavior table (the associations can be done interactively using
the SAS Profitability Management GUI, or can be imported from a file that specifies the associations).

. specifies which rows in a transaction table group to include in the calculation.

. specifies what quantity to include in the calculation.

A rule definition table contains the following columns:

Name Maximum Length Description

The name of the transaction table group in the model in which

Table Group Name | Char 64 the assignment rule will be applied

The name for the assignment rule; this must be unique within

Name Char 64 the model
Selection Criteria Char 1024 The formula defining the filter logic
Driver Formula Char 1024 The formula defining the calculated quantity

In a rule definition table, consider the following rules:

. The columns must have the length that is shown.

. The order of the columns is arbitrary.

. The column name is arbitrary.

. If any column is blank, it is an error and the row is not imported.

. If an assignment rule with the name already exists, it is an error and the row is not imported.

. If the table group name is not found, it is an error and the row is not imported.
Related Topics:

. Import a rule definition table

. Import a rule association table

. Rule association table
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Index of Terms

Assignment rule

Behavior table

Calculated value

Custom dimensions table

Detail report

Driver formula

Driver quantity

Profitability model

Period dimensions table

Report hierarchy table

Report layout table

Rule association table (for importing)

Rule definition table (for importing)

Summary report

Transaction table

Transaction table group

Unit value/Total value

Value
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Add Labels to a Report

You can add labels to your reports. For each label, add a row that contains the following data to the
report layout table:

1. The id field, which is a string. The string is arbitrary but must be unique and cannot occur
elsewhere in the ID field of either the report layout table or the report hierarchy table.

2. The name field, which is a string that is the label. The maximum length is 32 characters.

3. The formula field, which contains "."

The following picture shows a report layout table with labels and the resulting report:

.@. id 4@}. name 4@3 formula @ rowlrder
lahe| —=1 |LABELT < nterest Income: [Ial:uel];k\ " 1
2 [100mM Credit Card [nterest F'a_l,lrnentg\\ 2
2 (10002 Loan Intereszt Payments 3
4 (10003 [Fvestment Securities Payments 4
B [TOT-MWT-IMC Tatal Interest Income N E{DEH] + [10002] + [10003] a]
labe| —= 5 [LABELZ < Interest Expense: [IaheD ".""Il B
¥ |111om Savings Interest Payments '|| 7
g (11002 Auto and Perzonal Loans || a
9 |11003 kuortgages \ I| |
10 | TAT-MNT-E=P Total Interest Expense [ 'IH] N1+ [11002] + [11003] 10
11 [HET-IMNTHMNC Met interest income [TD#-INT-INE]-[TDT-INT-EHF‘] 11
lahe| —» 12 |LABEL3 Moninterest Income: [label] " I|"|I 12
:i ;ggg; f view> Dataw Properties x X
15 {20003 Year 2006 2007
16 | 20004
17 | TOT-MOMINT-| |4 L2 L3
labhe| —18 |LABELS
19 | 210M Interest Income: (label)
Credit Card Interest Payments 2963
Interest Income Loan Infzrest Payments 133

Investfment Securities Payments 1258

Total Interest Income 2654
Interest Expense: (label)

Savings Interest Payments ri
Interest Expense Auto and Personal Loans 783
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Interest Expense Auta and Personal Loans 783

rAQFToaes 1RER3
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Menus for Behaviors

w File Edt “iew Achon: Help

Bebawvions

Edit

View

Organize Models - Displays all available models on this server
Create a New Association - Associates an assignment rule with a behavior
Properties - Displays the properties for the selected items

Exit - Closes the application

Clear Association - Removes the association between an assignment rule and
a behavior

Clear all associations - Clears all assignment rule associations

Server Configuration - Displays the server storage location and repository
information for SAS Profitability Management, for all models on the server

Transactions - Opens the Transactions workspace
Rules - Opens the Rules workspace

Behaviors - Opens the Behaviors workspace
Reports - Opens the Reports workspace

Audit Log - Displays the audit log

Workspace List - Displays or suppresses the workspace list in the current
workspace
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Task List - Displays or suppresses the task list in the current workspace

Actions

Help

Calculate Model - Calculates a model by taking the transaction tables in the
input directory, applying rules in the model to make calculations, and storing the
calculated results in columns that are appended to the transaction tables in the

output directory

Import Associations - Imports a file that associates assignment rules with
behaviors

Export Associations - Exports a file that associates assignment rules with
behaviors

Refresh - Refreshes the screen to display the current status of all table source
data; when you change the underlying SAS tables, you should always refresh
the model before you continue editing the content in SAS Profitability
Management

Contents - Opens the Help file
PM on the Web - Links to the SAS Profitability Management Web site

SAS on the Web - Links to http://www.sas.com/

About - Provides version information for the application
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Menus for Reports

5 File Edt “iew Achon: Help
iy

Heports

Summary Reports Tab

File

Edit

View

Organize Models - Displays all available models on this server
New Summary Report Definition - Creates a new summary report
Properties - Displays the properties for the selected items

Exit - Closes the application

Remove - Removes the selected item from the SAS Profitability Management
model

Server Configuration - Displays the server storage location and repository
information for SAS Profitability Management, for all models on the server

. Transactions - Opens the Transactions workspace

Rules - Opens the Rules workspace
Behaviors - Opens the Behaviors workspace
Reports - Opens the Reports workspace
Audit Log - Displays the audit log

Workspace List - Displays or suppresses the workspace list in the current
workspace
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. Task List - Displays or suppresses the task list in the current workspace
Actions

. Calculate Model - Calculates a model by taking the transaction tables in the
input directory, applying rules in the model to make calculations, and storing the
calculated results in columns that are appended to the transaction tables in the

output directory

Generate Cube - Generates a cube for a SAS Profitability Management model

. Refresh - Refreshes the screen to display the current status of all table source
data; when you change the underlying SAS tables, you should always refresh
the model before you continue editing the content in SAS Profitability
Management

Help

Contents - Opens the Help file
. PMon the Web - Links to the SAS Profitability Management Web site

. SAS on the Web - Links to http://www.sas.com/

. About - Provides version information for the application

Detail Reports Tab
File
Organize Models - Displays all available models on this server
New Detail Report Definition - Creates a new detail report
. Properties - Displays the properties for the selected items
. Exit - Closes the application
Edit
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View

Remove - Removes the selected item from the SAS Profitability Management
model

Server Configuration - Displays the server storage location and repository
information for SAS Profitability Management, for all models on the server

Transactions - Opens the Transactions workspace
Rules - Opens the Rules workspace

Behaviors - Opens the Behaviors workspace
Reports - Opens the Reports workspace

Audit Log - Displays the audit log

Workspace List - Displays or suppresses the workspace list in the current
workspace

Task List - Displays or suppresses the task list in the current workspace

Actions

Help

Calculate Model - Calculates a model by taking the transaction tables in the
input directory, applying rules in the model to make calculations, and storing the
calculated results in columns that are appended to the transaction tables in the

output directory

Refresh - Refreshes the screen to display the current status of all table source
data; when you change the underlying SAS tables, you should always refresh
the model before you continue editing the content in SAS Profitability
Management

Help Contents - Opens the Help file
PM on the Web - Links to the SAS Profitability Management Web site

SAS on the Web - Links to http://www.sas.com/
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. About - Provides version information for the application
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Menus for Rules

Edit

View

File Edit “iew Acton: Help

Organize Models - Displays all available models on this server
Add Assignment Rule - Adds an assignment rule to the current model
Properties - Displays the properties for the selected items

Exit - Closes the application

Copy Assignment Rule - Makes a copy, with a new name, of an assignment
rule

Remove - Removes the selected item from the SAS Profitability Management
model

Delete all assignment rules - Deletes all assignment rules

Server Configuration - Displays the server storage location and repository
information for SAS Profitability Management, for all models on the server

Transactions - Opens the Transactions workspace
Rules - Opens the Rules workspace

Behaviors - Opens the Behaviors workspace
Reports - Opens the Reports workspace

Audit Log - Displays the audit log

55



Workspace List - Displays or suppresses the workspace list in the current
workspace

Task List - Displays or suppresses the task list in the current workspace

Actions

Help

Calculate Model - Calculates a model by taking the transaction tables in the
input directory, applying rules in the model to make calculations, and storing the
calculated results in columns that are appended to the transaction tables in the

output directory

Import Assignment Rules - Imports a file defining rules that associate rows in
a group of transaction tables with a behavior

Export Assignment Rules - Exports a file defining rules that associate rows in
a group of transaction tables with a behavior

Refresh - Refreshes the screen to display the current status of all table source
data; when you change the underlying SAS tables, you should always refresh
the model before you continue editing the content in SAS Profitability
Management

Contents - Opens the Help file
PM on the Web - Links to the SAS Profitability Management Web site

SAS on the Web - Links to http://www.sas.com/

About - Provides version information for the application
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Menus for Transactions

E File Edit %iew Actions Help

{ransactions

File

Organize Models - Displays all available models on this server

. Add Table Group - Adds a table group to the current model

. Add Transaction Tables - Adds a transaction table to the selected table group

Edit

View

Properties - Displays the properties for the selected items

Exit - Closes the application

Remove - Removes the selected item from the SAS Profitability Management
model

Analysis Settings - Defines the settings for time periods and measures format

Server Configuration - Displays the server storage location and repository
information for SAS Profitability Management, for all models on the server

Transactions - Opens the Transactions workspace
Rules - Opens the Rules workspace

Behaviors - Opens the Behaviors workspace
Reports - Opens the Reports workspace

Audit Log - Displays the audit log

Workspace List - Displays or suppresses the workspace list in the current
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workspace

. Task List - Displays or suppresses the task list in the current workspace
Actions

. Calculate Model - Calculates a model by taking the transaction tables in the
input directory, applying rules in the model to make calculations, and storing the
calculated results in columns that are appended to the transaction tables in the

output directory

. Refresh - Refreshes the screen to display the current status of all table source
data; when you change the underlying SAS tables, you should always refresh
the model before you continue editing the content in SAS Profitability
Management

. Preview Data - Previews the first 1000 rows of data in a table

Help

Help Contents - Opens the Help file

PM on the Web - Links to the SAS Profitability Management Web site

. SAS on the Web - Links to http://www.sas.com/

. About - Provides version information for the application
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‘ = H e ‘3. Create a New Profitability Model

A profitability model contains the following tables:

Behavior
. Period Dimensions
. Transaction (organized into table groups)
. Custom Dimensions

Report Hierarchy

. Report Layout
To create a new profitability model, perform the following steps:

1. Select File » Organize Models.
The Organize Models window opens.
2. Click New Model.
The Add Model wizard opens.
3. On the Information page, name the model.
4. Click Select to select the time dimension for the model.
The Select Table window opens. Select a time dimension, and then click OK.
5. To preview the data in the time dimension table, click Preview.
The Preview window opens and the time dimension table is displayed.
6. Click OK, and then click Next.
7. On the Analysis View and Output Library page, name the analysis view.
The analysis view name is used as the name of the database view that is
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10.

11.

12.

13.

14.

15.

16.

17.

18.

19.

created to join the transaction output tables into a single virtual fact table that
the OLAP cube is built from.

. Click Select to select the analysis view library.

The Select Library window opens. Select a library, and then click OK.

. Click Select to select the output directory for analysis results.

The Select Library window opens. Select a library, and then click OK.
Click Next.

On the Data Location page, verify the storage locations for external data, and
then click Next.

Note: The storage locations were established during installation. You do not
have to change them now.

On the Behavior table page, select a behavior table.

To preview the data in the behavior table, click Preview.
The Preview window opens and the behavior table is displayed.
Identify each of its required fields, and then click Next.

On the Dimension Tables page, select the dimension tables.

Note: It is not necessary to add the time dimension because it has already been
identified in a previous step.

To preview a dimension table, select one from either list in the Add Dimension
Tables window or the list on the Dimension Tables page, and then click
Preview.

The Preview window opens and the dimension table is displayed.
Click Next.

On the Report Tables page, select the report hierarchy.

Select the report layout.
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20. To preview the data in either the report hierarchy table or the report layout table,
click Preview.

The Preview window opens and the report hierarchy table is displayed.
21. Click Finish.
The new profitability model is added to the Organize Models window.

22. Click Close.
Related Topics:

. Edit a model
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Profitability Model
A profitability model contains the following tables:

. Behavior

. Report Hierarchy

. Report Layout

. Period Dimensions

. Custom Dimensions

. Transaction (organized into table groups)
The following picture shows the relationships between the behavior table and the other tables in a profitability model.

Feport Layout
ID Name  Formula

Calculated Transaction Tahle
CustlD Amount Quantity Value Behavior

otalFees x+y+z

Eehavior Table

Fegiod D Name TotalValue UnitValue
_'_‘_,.F"P
1

‘bEpnsit $10
2 Balance . 52
2 Transfer . 52
A
Fepart Hierarchy Fule Associations

uleName Behavior

x ' Fees Deposit
y |Fees Balance
z / Fees Transfer

The following pictures shows additional relationships among the tables that make up a profitability model:
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Cluantity = Formula

Table Group 2 Value=Cluantity = Unitvalue

Transaction1

CustlD Amaunt
3
4
Name TableGroup Criteria @ 3 Transadfion & (cajcul

Fules
1 i CustiD=1 Amount CustlD Amount Quantlty ‘u‘alue Eehavlur
Eehavior Table @ 2 um 2 9 4
Period ID Name TotalValue UnitValue 3 —7 3 § 6
4 B 23 x
1 x Deposit $10 . | - (added fields)
y. Balance . $2 \ Fule associations transaction table is associated
z"{ansﬁer ; $2 RuleMame Behavior with ane period
oA X Time dimension
@ Y ID year half-year
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Create a New Profitability Model

1. Select File » Organize Models.
The Organize Models window opens.
2. Click New Model.

The Add Model wizard opens.

FiZ sAS profitability Management - BabyBank

Click Organize Models AL —!—E'..”T

Transacticas A
%& Organize Models

Click New Model AIBTIMFE TEI Tk
Bank_M3

Mike_Maodel
MAC_Tank
Pr_TCA_ONE

3. On the Information page, hame the model.
4. Click Select to select the time dimension for the model.
The Select Table window opens. Select a time dimension, and then click OK.
5. To preview the data in the time dimension table, click Preview.
The Preview window opens and the time dimension table is displayed.
6. Click OK, and then click Next.

§ Add Model

Information

Enter the model name and select the time dimension.

Type a name

s _ewwn. |
1
Select Table O] x|

Srowesn ||

64 | [ calLCENTER Q4a -
i Bl calLLcENTER_Q4E
H o cHAMMEL —



- CALLCENTER_Q4A
- CALLCENTER_Q4B
- [ DIM_CHANNEL
- DIM_CUSTOMER,
- DIM_CUSTTYPE

Select a time dimension

7. On the Analysis View and Output Library page, name the analysis view.

The analysis view name is used as the name of the database view that is created to join the transaction output tables into a single
virtual fact table that the OLAP cube is built from.

8. Click Select to select the analysis view library.

The Select Library window opens. Select a library, and then click OK.
9. Click Select to select the output directory for analysis results.

The Select Library window opens. Select a library, and then click OK.

10. Click Next.

§ Add Model

Analysis View and Output Library
Specify the options for the analysis view and output library.

Name the analysis view

Select a wview library (2] BNAC_Beg
Select an output library {ZP BNAC_Beg

11. On the Data Location page, verify the storage locations for external data, and then click Next.

Note: The storage locations were established during installation. You do not have to change them now.

65



B Add Model

Data Location

Specify the locations o store extemal model data,

Server falder: |E:\SAS'\F’eritabiIit_l,lM anagements D atatieritodels\Bank_Model
Metadata folder; I.v'F'mﬁtabiIit_l,lM anagement/Modelz/ Bank_kModel

Specify storage locations ——»

cBack | Hes Y[ Enish | Cancel

12. On the Behavior table page, select a behavior table.
13. To preview the data in the behavior table, click Preview.
The Preview window opens and the behavior table is displayed.

14. Identify each of its required fields, and then click Next.

_|o| x|
Repository: |@ Foundation | w |
Available tables:
-(z) BNAC_ Beg =
Select a behavior takle > ] AssocraTIoN -
[ feEHAVIOR
] caLLCENTER_Q1a
] caLLCENTER_Q1E
B caLLCENTER_Q2a
& Add Model & carceneR oz =l
Behavior Table oK Cancel |
Specify the behavior table and map columns.
— ]
Behavior table: |%BEHA'U‘IOR | Select... | Preview... |
Column mapping:
Required Column | Map to Source Column
Id An1o v
MName @Name ﬂ
Unit Value i@ Unitvalue ﬂ
Total Value i Totalvalue ﬂ
Period @'ﬁme Bl

tTime

An1D D

Ientify each required
colurnn in the behavior table

v

@Name MName
By AssignmentRule AssignmentRule

15. On the Dimension Tables page, select the dimension tables.
Note: It is not necessary to add the time dimension because it has already been identified in a previous step.
16. To preview a dimension table, select one from either list in the Add Dimension Tables window or the list on the Dimension Tables page,

and then click Preview.
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17.

18.

19.

20.

21.

The Preview window opens.

Click Next.

iy Add Dimension Tables

N

Add dimension tables

On the Report Tables page, select the report hierarchy.
Select the report layout.

To preview the data in either the report hierarchy table or the report layout table, click Preview.
The Preview window opens and the report hierarchy table is displayed.

Click Finish.
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Select & report higrarchy

Select a report layout

=10l x|

Gromseen | 4]

ii#i Select Table

& Add Model

Report Tables
Specify the report hierarchy and layout tables.

i Select Table

R ]

----- FH LOAD_TRANS_Q3B
----- EH LOAD_TRANS_Q4A

The new profitability model is added to the Organize Models window.

22. Click Close.

i@ Organize Models

AIRTIME TELCOM
Bank_M3
Bank_Sample
Chip_Test

Mike Maodel
MaC_Tank,

MHew kodel

Mews model

Related Topics:

. Edit a model

= Bank haodel
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Period Dimensions Table

A period dimensions table defines the time periods to be used. The number of levels in the period dimensions table depends
on your reporting needs. A period dimensions table contains the following columns:

Position [Name Maximum Length Description
1 ID Char 32 The identifying value for the period
5 L3 Scenario lchar 32 Third-level dimension member value (for example, Actual or
- Budget)
3 L1 Year Char 32 Top-level dimension member value (for example, 2006)

Second-level dimension member value (for example,

4 L2 Quarter Char 32 2006_Q4)

In a period dimensions table, consider the following rules:

. The columns must appear in the order that is shown.
. Each column must have the length that is shown.
. The name of the column is arbitrary.

. The number of levels is arbitrary.

The following picture shows a sample period dimensions table:

™= YIEWTABLE: Dim_period
D | L1 Scenario | L2 “ear | L3 Quarter -
1 2006_01_Actual Actual 2006 2006_01
2 2006_02_Actual Actual 2006 2006_Q2
3 2006_03 Actual Actual 2008 2006_073
4 2006_04_Actual Actual 2006 2006_04
] 2006_01_Budget Budoet 2006 2006_01
G 2006_02 Budget Budoet 2006 2006_Q2
7 2006_0)3 Budget Budget 2008 2006_073 b
g 2006_014_Budget Budget 2008 2006_04 -
T | s

The following picture shows the relationship between this sample period dimensions table and the resulting profit-and-loss
report:
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ABLE: Dim_period
1D

2006_C1_Actual Actual
2006 02 Actual Actual
2006_03 Actual

Filer Data™ ‘iew=

orill Path:

L1_Scenario > Actual = 2006

B vieww Dataw Properties

2006_01
2006_012
2006_013

i 7 H & ] il ® L Preference

a X

& X

Related Topics:

L1_Profit L2 Profit

Credit Carg-ipterest Incorme

L

L3 Quarter  [#] 3] 2006_01

Add a new period to the period dimension table
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‘4— H i ‘ 1. Populate the Input Directory

Your input directory must contain the following tables:

. Behavior

. Report Hierarchy

. Report Layout

. Period Dimensions

. Custom Dimensions

. Transaction

The input directory can contain the following tables:

. Rule Definition

. Rule Association

A profitability model ties these tables together.

Notes:

. In addition to the required columns, all of the tables can contain additional
columns without causing any problems.

. The following characters are not valid in reports (cubes):

I ?2*& %S -+=()[1{}/\
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Preview the Data in a Table

To preview the data in a table, perform the following steps:
1. Activate the Transactions workspace.
2. Select a model and a table.

3. Click Preview Data, or select Actions ¥ Preview Data.

The Preview window opens.
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The TRANASSIGN Procedure

Overview

Syntax:
TRANASSIGN Procedure

PROC TRANASSIGN Statement
TRANSACTION Statement
DIMENSION Statement

Example
ChildOf Function

Overview

The TRANASSIGN procedure provides a batch method for calculating a SAS Profitability Management model.
The procedure takes the transaction tables in your input directory, applies rules in the model to make
calculations, and stores the calculated results in columns that are appended to your transaction tables in the

output directory. Errors and warnings are written to the SAS log file.

Syntax:

PROC TRANASSIGN
AR=assignment-rule-table
BH=behavior-table
TS=transaction-schema-table;

TRANSACTION
DATA-=transaction-table
OUTPUT=output-table
PERIOD="period-name'

TY PE="transaction-table-group’;

DIMENSION
NAM E=dimension-name
TABLE=dimension-table;

PROC TRANASSIGN Statement

The PROC TRANASSIGN statement specifies the input data sources for transaction table schema, transaction
behaviors, and assignment rules.

PROC TRANASSIGN
AR=assignment-rule-table
BH=behavior-table
TS=transaction-schema-table;

Required Arguments:

AR | ASSIGNMENTRULE=assignment-rule-table
Specifies the data source for the assignment rule table. The table must conform to the following schema:
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Name Data |[Maximum |Description
Type |Length

Name  |Char |64 The name of the assignment rule

Condition |Char [4096 The expression that is used to select transactions as assignment
destinations; the expression should be SAS-compliant and only use
variables from the transaction table; the only exception is that it can use
the customized dimension-member filtering function ChildOf

Formula |Char [4096 The formula expression that is used to calculate the driver quantity for a
particular assignment; the expression must be SAS-compliant and only
use variables from the transaction table

Type Char |64 The transaction table group that the assignment rule applies to; the
value of this field is matched by the value of the TYPE parameter in a
TRANSACTION statement

BH | BEHAVIOR=behavior-table

Specifies the data source for the behavior table. The behavior table must conform to the following

schema:
Name Data Maximum |Description
Type Length
Name Char (32 'The name of the behavior
Period Char |64 The period name for the behavior row
AssignmentRule ’Char ’64 The name of the assignment rule used by the
behavior
TotalValue IDouble ’ The total cost/revenue value for the behavior row
Unitvalue Double | The unit cost/revenue value for the behavior row

Note: This behavior table is not identical to the behavior table that is used by a SAS Profitability Management
model. Whereas the TRANASSIGN behavior table contains an AssignmentRule field, the SAS Profitability
Management model behavior table does not contain such a field. Internally, SAS Profitability Management
combines its behavior table with a rule association table to append an AssignmentRule field to produce the
kind of behavior table that is used by the TRANASSIGN procedure.

TS | TRANSCHEMA-=transaction-schema-table
Specifies the data source for the transaction-schema table. The table must conform to the following

schema:
Name Data Maximum Description
Type Length

Type Char 64 The transaction table group to which a transaction
table belongs; the value of this field is matched by the
value of the TYPE parameter in a TRANSACTION
statement

Column Char 64 The name of the column

Output Char 1 Is it part of the output (dimension or measure): 'Y' or
'N' ?

74




Note that the transaction schema table can contain multiple schemas. There is one schema per
transaction table group. The Type field in the transaction schema table contains a string that identifies
the transaction table group. The following is a sample transaction schema table:

A Type [ Column |/ Output
1 |ABMCost AMT N
2 |ABMCost AgzignmentFule N
3 |ABMCost Channel N
4 |[ABMCost Count N
h [ABMCost CustlD N
6 |ABMCost CustType Nl
¥ [ABMCost Fraduct Nl
g8 |ABMCost Reqion N
q |CallCenter Channel N
10 | CallCenter Communication N
11 |CalCenter © implaints
" 1
_ailenter o ¥
21 |Revenue ahT Nl
22 |Revenue Channel N
23 | Revenue CustlD Y
24 |Revenue CustType Nl
25 | Revenue D Y
26 | Revenue Fraduct Nl
27 | Revenue Feqgion Nl

TRANSACTION Statement

The TRANSACTION statement specifies the input data source for a transaction table. It is also used to specify
the transaction type, the period for the transaction table, and the data source for the output table. The
statement specifies the action (overwrite or append) when there is a pre-existing output table with the same
name. At least one TRANSACTION statement is required for a TRANASSIGN procedure.

TRANSACTION
DATA-=transaction-table
OUTPUT=output-table
PERIOD="period-name'

TY PE="transaction-table-group'

Required Arguments:

DATA=transaction-table
Specifies the data source for the transaction table. Its schema must match the value of the TYPE
parameter.

OUTPUT=output-table
Specifies the output table for the resulting transaction table. The schema of the output table is based on
the transaction table schema that is specified in the TRANSCHEMA parameter in the PROC
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TRANASSIGN statement. All columns that are specified as output columns for the transaction table are
in the output table. In addition, the following columns are part of the schema for the output table:

Name Data Maximum Description
Type Length
Behavior Char 32 The name of the behavior that corresponds to the
assignment
Quantity IDouble The driver quantity of the assignment
Value IDouble The cost/revenue that flows through the assignment

PERIOD="period-name'
Specifies the period for the transaction table. The period information determines the corresponding
behavior rows for the transaction assignment.

TYPE="transaction-table-group’
Specifies the name of the transaction table group to which this transaction table belongs. The
transaction table group determines the schema of the transaction table. Every transaction table in a
group must share the same schema. The schema for a transaction table group is in the table specified
by the TRANSCHEMA parameter in the PROC TRANASSIGN statement.

DIMENSION Statement

The DIMENSION statement defines the dimensional mappings in the transaction assignment. An assignment
rule can use a condition that has an external dimension that does not live in the transaction table. This
statement defines the data source for the external dimension table, and the key mapping between the
transaction table and the dimension table. The DIMENSION statement is optional for a TRANASSIGN

procedure.

DIMENSION
NAM E=dimension-name
TABLE=dimension-table;

Required Arguments:

NAME=dimension-name
Specifies the name of the dimension. The dimension name is referenced in an assignment rule's

condition.

TABLE=dimension-table
Specifies the data source for the dimension table. Each dimension table must follow the following

column ordering and length, although the name of each column is arbitrary:

Name Data Maximum Description
Type Length
Key IChar 132 The primary key for the dimension table

|L1 |Char |32 ]The level 1 member
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|L2 |Char |32 ]The level 2 members

|Ln |Char |32 ]The level n mm

Example

In the following example, the caller invokes the TRANASSIGN procedure to process two transaction tables and
write the output to the same data source. The REGION dimension is used for dimension-member filtering:

[ i bnane nodel .;
[ i bname nodel Qut . ;

PRCC TRANASSI GN
TranSchema=Tr anSchena
Behavi or =Behavi or
Assi gnment Rul e=Rul e;

Transacti on Dat a=nodel . At mD4Q3 Peri od=' 2004_Q@3"' Type=' General' Qut put=nodel Qut.
ATMut ;

Transacti on Dat a=nodel . At nD4Q4 Peri od=' 2004 Q' Type=' General' Qutput= nodel CQut.
ATMut ;

Di nensi on Nanme=' Regi on' Tabl e=nodel . Di nRegi on;

RUN,;

ChildOf Function
double IsChildOf(dim_member_column_in_transaction_table, parent_dim_member_full_name);

The ChildOf function returns 1 when the corresponding dimension member for the current transaction row is a
descendant of the member parent_dim_member_full_name. Otherwise, it returns 0.

The first parameter specifies the column name of the dimension member in the transaction table. This
parameter should not be in quotation marks.

The second parameter specifies the full name of a parent dimension member. The syntax of
dim_member_full_name is similar to MDX (multidimensional expressions). Square brackets enclose the
name of a single dimension member. The full name must start with the dimension name, and it must contain
the name of each level for the parent dimension member. This parameter must be in quotation marks.

Examples for calling this function include:
. IsChildOf(Region, "[Region].[USA].[North Carolina]")
. IsChildOf(Product, "[Product].[Paper Goods].[Tissue Paper[429x340]]]")

. IsChildOf(Product, '[Product].[Beverages].[Fred"s choice]’)
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The examples demonstrate the following rules:

. Both single quotation marks and double quotation marks can enclose strings.
. "]"is used as an escape character for embedded closing square bracket.

. A single quotation mark is used as an escape character for an embedded single quotation mark.
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F| Quick Start

1. Populate the input directory

2. Set up the environment

3. Create a new profitability model

4. Define transaction table groups

5. Define rules

6. Calculate a model

7. Prepare reports

8. View reports

Take the SAS Profitability Management Tutorial to familiarize yourself with this
software.
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Reference

Index of terms

Menus and toolbars

. The TRANASSIGN Procedure
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Define a Detail Report |Showme]

Each detail report is available to produce a report that is based on a single dimension
and by filtering a single value in that dimension. Detail reports are run from the SAS
Profitability Management Web Client and create a cube on the fly. To configure a
detail report, perform the following steps:

1.

2.

Activate the Reports workspace, and then select a model.
Click the Detail Reports tab, and then click New detail report definition.

The New Detail Report Definition wizard opens.

. On the Information page, select a detail report, and then click Next.

. On the Dimensions and levels page, select the dimensions.

Note: Although all of the columns in all of the tables of the model are displayed,
only those columns corresponding to dimensions should be selected to produce
the most meaningful report. For the best response time, select dimensions with
a limited number of records. Three dimensions are automatically selected: the
column that you selected in the previous step, the DIM_PERIOD dimension,
and the REPORTHIERARCHY dimension. These dimensions are automatically
selected and disabled because they are required for the report. However, you
can select the levels of these dimensions.

In the Allow Drill Down To column, select the level for each dimension.

. Click Next.

. On the Measure page, select the measures to be included in the detail report.

Note: Value is automatically selected and disabled because it is required for the
report.

. Click Finish.

After the selected dimensions are configured, the list of detail reports is
displayed on the Detail Reports tab of the Reports workspace. This is the
same list of detail reports that will be available in the SAS PRofitability
Management Web Client for viewing.
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Define a Detail Report

1. Activate the Reports workspace, and then select a model.
2. Click the Detail Reports tab, and then click New detail report definition.

The New Detail Reports Definition wizard opens.

.2 SAS Profitability Management - BabyBank

Select a model - — . s I

E:. Reports
Click Detail Reports tab

Click New detail report definition

F?:'

=

Reports workspace

3. On the Information page, select a detail report, and then click Next.

&, New Detail Report Definition

Information
Select a report that will be generated.

4. On the Dimensions and levels page, select the dimensions.
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Note: Although all of the columns in all of the tables of the model are displayed, only those columns corresponding to dimensions
should be selected to produce the most meaningful report. For the best response time, select dimensions with a limited number of
records. Three dimensions are automatically selected: the column that you selected in the previous step, the DIM_PERIOD
dimension, and the REPORTHIERARCHY dimension. These dimensions are automatically selected and disabled because they
are required for the report. However, you can select the levels of these dimensions.

5. From the Allow Drill Down To column, select the level for each dimension.

6. Click Next.

& new Detail Report Definition

Dimensions and levels

Select the dimensions and the level you want to be able to drill to.

Available dimensions ———————% Indude | Dimensions | Allow Drill Down To

= DIM_CHANMEL L1_Channel o
= DIM_PERIOD g L1 Scenario ll
¥ REPORTHIERARCHY = L2_Profit ~|
C DIM_CUSTOMER L1 Type _|
7 DIM_CUSTTYPE S L1 CType ~|
- DIM_PRODUCT L1_Product _|
r DIM_REGION L1 Area _

< Back Mext = | Einish I Cancel

7. On the Measure page, select the measures to be included in the detail report.
Note: VALUE is automatically selected and disabled because it is required for the report.
8. Click Finish.

After the selected dimensions are configured, the list of detail reports is displayed on the Detail Reports tab of the Reports
workspace. This is the same list of detail reports that will be available in the SAS PRofitability Management Web Client for
viewing.
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&, New Detail Report Definition

Measures
Select the measures,

Awvailable measures
VALUE
AMT

Communication
Complaints
Count
CrozsSel
Inquiry

~
r
r
r
r
r
r
r
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Report Hierarchy Table

The report hierarchy table defines the dimension hierarchy for drilling down into the profit-and-loss report. The number of levels in the hierarchy is a critical decision in model
design and is subject to the ultimate reporting needs for the business managers to make decisions. A report hierarchy contains the following columns.

Position |Name Maximum Length Description
1 ID Char 32 The identifying reference for the behavior
2 L1_Profit Char 32 Top-level dimension members for the hierarchy
3 L2_Profit Char 32 Second-level dimension members for the hierarchy
4 L3_Profit Char 32 Third-level dimension members for the hierarchy
5 L4_Profit Char 32 Fourth-level dimension members for the hierarchy
6 L5_Profit Char 32 Fifth-level dimension members for the hierarchy

In a report hierarchy table, consider the following rules:
. The columns must appear in the order that is shown.
. Each column must have the length that is shown.
. The name of the column is arbitrary.

. The number of levels is arbitrary.

The following picture shows a sample report hierarchy table:

" YIEWTABLE: Pm_buzz.Reporthierarchy

o | L1_Profit | L2_Profit L3_Profit | L4_Prafit LE_Profi | =
1 20002 Direct Product Cogt to Acquire CCT aTe CCT_OTP_Manage transactions
2 20003 Direct Product Cost to Provide ATH CHE ATM_CHE_Check balance
3 20004 Direct Product Cost to Provide AT CHE ATM_CHE_Deposits
4 20005 Direct Product Cost to Provide ATk CHE. ATW_CHE_Fund Transfer
5 20008 Direct Product Cost to Provide ATH CHE ATM_CHE_withdrawals
B 20007 Direct Product Cost to Provide AT CRC ATM_CRC_withdrawals
7 20008 Direct Product Cost to Provide ATH aTe ATM_OTP_Manage tranzactions
8 20009 Direct Product Cost to Provide AT REC ATM_REC_Deposits
g

[
=
=

20010 Direct Product Cost to Provide AT SAN ATM_SAY Check balal
wgrt Produc Co ide SANY Thi_Sab ozits

Note: Do not include calculated rows from the report layout table, such as the following row, in the report hierarchy table:

| In} | M ame | Farmula
4 |TOTINTANC  Total Interest Income [10007 J+[10002}+[10003]

The following picture shows the relationship between this sample report hierarchy table and the resulting profit-and-loss report:

II'EI_ YIEWTABLE: Pm_buzz.Reporthierarchy

o | L1_Profit | L2_Prafit | L3 Profit | L4 Profit | LE_Prafit | =

1 20002 Direct Product Cost to Acquire CCT aTte CCT_OTP_Manage transactions

2 20003 Direct Praduct Cost to Provide ATH CHE. ATM_CHE_Check balance

3 20004 Direct Product Cost to Provide ATH CHE, ATM CHE Deposits

4 20005 Direct Product Cozt to Provide

] 20006 Dfrect Product Cost to F'ro\tfde Fle FEdt Wiew Favortes Tools  Help

g 20007 Direct Product Cost to Provide - = - -

7 20008 Direct Product Cost bo Provide O Back = \_) - \ﬂ @ .'_\J | P ! Search \;\7’ Favarites é:‘v = - ﬁ ‘i“

g 20009 Direct Product Cost to Provide

g 20m0 Direct Praduct Cast to Provide Address Iﬁj http:,l',l'abmmoe.na.sas.-:c-m:BDBD,I'SF\SWebOLAP\-'iewer,l'visualdataexplorer.do?saspFs_sessic-nid=?c6ab1a9b61j Go

= 20m “wget Produg Co; ide ff pmusert | H
SAS Web OLAP Viewer - Untitled Data Exploration G
248 Serv ort st bo Retal s s . .
— Filew Datav ‘ieww iz 1 B

249|730 Servicing Effort Cost to Fietain (7 Query| 3 Navigator & Bookmarks | 44 ¥ B I B e L
250 23057 Seicing Effor Cost to Fietain I Query &
251 23058 Servicing Effort Cost to Retain Selected |tems: Drill Path: # ¥ Applied Filters:
252 23059 Servicing Effort Cost to Retain =
253 |23060  Servicing Effort Cost to Fietain EE3 Rows =
254 | 23061 Servicing Effort Cost to Suztain Business T, REPORTHIERARCHYSet
285 (10001 Interest Income Credit Card interest [ncome —_ | Ea columns F views  Dataw Properties A %

286 |10002 Interest Income Interest Income

257 11003 Interest Expense Investmer (=53 F'\qkl-n;a'ﬁls\‘- L1 Year 2006
258 110 Interest Expenze Savings Interest Paymeri -

259 11002 Interest Expense Certificates of Deposit Payments L2 Profit

260 10003 Interest Income Mortgages Income -

261 |1200m Fees Credit Card Fees D Credit Card interest Income EIEIEA53
262 12002 Fees ATH Fees Available [terms:

263 12003 Fees |hvestment Account Fees ; ; [ Interest Income Loan Interest Income 1497558002
264 12004 Fees Checking Account Fees 'B BPM_AL_Dim_Details

265 13001 Funds Credit for Funds VALLE 85 Mortgages Incorme #17703367
266 |13002 Funds Charge For Funds DIt4_PERIOD

Total Interest Income 3153645895

267 14007 Provision For Loszes

REPORTHIERARCHY et



264 | 12004

2B6

268
263

271

265

267

270

13001
13002
14001
20000
21000
22000
23000

Fees Checking Account Fees
Funds Credit for Funds

Fundz Charge For Funds
Provision For Loszes

Direct Product

Relationship Managerment
Sales and Marketing Effort
Servicing Effart

g =T TV IR i

B LUE

\—\‘ﬂ hortgages Income

817703367
=, DIM_PERICD Total Interect |
o otal Interest Income 5
- REPORTHIERARCHY S et 315384583
B, DIM_CHANNEL Savings Interest Payments 100526257
Dl _CUSTOMER | Interest Expense  Certificates of Deposit Payments 490032611
Apply Restore Investment Securities Pavments  qon3gosss
Total Interest Expense AON94876%
4 |
|§] http:ffabmmoe.na. sas, com;: 8080/ 5ASWebOLAPYiewer logoff .do l_l_l_l_ ’_ "-_-4 Local intranet
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Report Layout Table

The report layout table defines the calculation formula for the profit-and-loss report. A report layout table contains the following columns:

Position [[Name Maximum Length Description
The unique identifying reference for the item
1 D Char 32 . IDs for source costs are based on the behavior IDs
. IDs for calculated values are defined here
2 Name Char 32 The name of the behavior
3 Formula Char 255 For calculated rows, the formula for the calculation is based on the IDs
4 RowOrder Numeric 8 The position of the row in the profit-and-loss report

In a report layout table, consider the following rules:

. The columns must appear in the order that is shown.

. Each column must have the length that is shown.

. The column names must be exactly as shown.

Note: You can add labels to a report.

The following picture shows a sample report layout table:

A.BLE: Pm_buzz.Reportlayout =] E3
10 | RENIE | Farmula |R|:|wEIn:Ier |;
1 10001 Credit Card interest Income 1
2 10002 Loan Interest Income 2
3 10003 tortgages Income 3
4 TOTAMT-IMC Total Interest Income 10007 1+[10002]+[10003] 4
B 11001 Savings Interest Payments I}
B 11002 Certificates of Deposit Payments B
7 11003 Ihwvestrent Securities Payments 7
g TOT-MT-EXP Total Interest Expenze [110071+[110021+[11003] g
g MET-IMT-IMC Met Interest Income [TOT-IMTAMCHTOT-IMT-E*F] 9
10 13001 Credit for Funds 10
11 13002 Charge For Funds 11
12 MET-FUMDS Met Funds [1300717-[13002] 12
13 12001 Credit Card Fees 13
14 12002 ATM Fees 14
15 12003 Investment Account Fees 15
16 12004 Checking Account Fees 16
17 TOT-HOMAMTAMC  Total Mon Interest Income [12001]+[12002]+[12003]+[12004] 17
18 14001 Prowvizion For Lozzes 18
13 20000 Direct Product 13
20 21000 Relationzhip M anagement 20
21 22000 Sales and M arketing Effort 21
22 23000 Servicing Effort 22
23 TOT-MOM-IMT-EXP  Total Mon Interest Expenze [14007 [+[200007+[271 000]+[22000]+[223000] 230
24 MET_COMTRIE Met Contribution [MET-INTAMC]+MET-FUNDS]+[TOT-MOMAMT-INC]HTOT-HOM-IMT-EXF]

1

>
1

Note: Do not include calculated rows, such as the following row, in the report hierarchy table:

D |

Marne |

Formula

4 TOT-AMTANC

Total Interezt Income

(10007 J+[1 0002]+[10003]

The following picture shows the relationship between this sample report layout table and the resulting profit-and-loss report:
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w ABLE: Pm_buzz.Reportlayout M=] E3
10 | M arne | Formula | Order [~
1 10001 Credit Card interest Income 1
2 10002 Loan Interest Income 2
3 10003 tortgages Income 3
4 TOTAMT-IMC Total Interest Income [10007]+[10002]+([10003] 4
5 11om Sa\-'fr?gs Interest F'ay_ 2Nt icrosoft Internet Explorer provided by SAS - |EI|£|
B 11002 Certificates of Depoz -
7 11003 Investment Securibies Bayments Help | i
g TOT-IMT-EXP Total Interest Expenze Oy Search k_;.“l_ Favarites = | . PR — ; i
: T Mo~ ’
4 MET-IMT-IMC Met Interest Income i"\( €3 = . —J ﬁ "j
10 (130 Credit for Funds F'.SWeI:uOLF'.F‘\.I'iewer,l'visualdataexplnrer.du:u?sasst_sessiu:unid=?c6ab1agbalj G0
11 13002 Charge For Funds
12 MET-FUMDS Met Funds
13 12001 Credit Card Fees
14 12002 ATM Fees
15 12003 Investment Account Fees (i bl @ L B E
16 12004 Checking Account Feesz
17 TOT-MOM-INT-IMC Tu:uta! Nnn Interast Income 2 % applied Filters:
18 14001 Prowizion For Lozzes
19 20000 Direct Product
20 21000 Felationzhip Management
21 22000 Salez and Marketing E ffort .
22 | 23000 Servicing Effort fa= Froperties 2 X
23 TOT-MOM-IMT-EXP  Total Mon Interest Expensze
24 |NET_CONTRIE Net Cintibution L1_tear 2008
4 q 0
I L1_Profit L2 _Profit
Add v Remove Credit Card interest Income 838334571 | |
Available [tems:
1| Interest Incomey, “Loan Interest Incorme
29 BPW_AIL Dirm_Details 1497558002
L UE Kortgages Income 817703367
-T2, DI %4_PERIOD o interest |
= otal (nterest INCame
- REPORTHIERARCHY St 133645899
----"-'p_mM_CHANNEL Savings Interest Payments 100526253
"":F'DIM—CUSTOMER -l Interest Expense  Certificates of Deposit Payments | 490032611
Apply | Restore | Investment Securities Payments | 100389398
Total Interest Expense EO094 8282
4| _'IJ

|€| http: ffabmmoe.na. sas. com: 8080/SASWebOLAPYiewer /logoff.do

|
I_ I_ I_ I_ I_ |H Local intranet
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Reports-Workspace Toolbar

IlIIE File Edit Yiew Actions Help
B a# X 2o & EaE

(ransactions
(click the toolbar)
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‘ ez H B ‘7. Prepare Reports

. Define a summary report

. Define a detail report
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Define a Summary Report

A summary report is a cube that is generated from the SAS Profitability Management
client for later viewing in the SAS Web OLAP Viewer.

1.

2.

Activate the Reports workspace, and then select a model.
Click New summary report definition.

The New Summary Report Definition wizard opens.

. On the Information page, hame the summary report, and then click Next.

. On the Dimensions and levels page, select the dimensions and levels, and then

click Next.

Note: The fewer dimensions and drill-down levels that you select, the smaller
the summary cube will be. Smaller summary cubes have better response time.

. On the Measures page, select the measures.

VALUE is included by default. All numeric properties are available.

. Click Finish.

The new report is added to the list of summary reports.

. Select the new report in the list of summary reports, and then click Generate

cube.

The cube is generated.

. Click Details to view the message log.
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Define a Summary Report

1. Activate the Reports workspace, and then select a model.

2. Click New summary report definition.

The New Summary Report Definition wizard opens.

[#Z sAs Profitability Management - BabyBank o ]

File Edit Wew Actions Help

Select a model J e I =4 I Fas I En'b I = I ww| EE L. |I'~"Iode|: IBahy’Bank j
E. Reports
Workspacss X | Summary Reports | petail Reports | | Tasks X|
Show properties
Transactions cEaiE
Ei Generate cube...
; o F%
Click New summary report definition . I— *EE Mew summary repart definition. ..
ules
Behaviors
Reports warkspace E,.
Reporis
= N — i

3. On the Information page, name the summary report, and then click Next.

ﬁ:, Hew Summary Report Definition

Information

Provide a name for the report that will be generated.

Location: /Profitabilitgt ahagement/Models/buzzB ankModel /R eports

Mame the report Hepart defintion narme: ﬁBank_Model_Eubel

% Hack | MHeut » | Finigh I Cancel

4. On the Dimensions and levels page, select the dimensions and levels, and then click Next.

Note: The fewer dimensions and drill-down levels that you select, the smaller the summary cube will be. Smaller summary cubes
have better response time.
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E_i. Mew Summary Report Definition

Dimensions and levels

Select the dimenszions and the level vou want to be able to drill to.

Include | Dimenszions | Allas Drill-Diown To
= DIM_PERIOD = L1 Year w
= REPORTHIERARCHY = L2 Pt ﬂ
¥ DIM_CHaNMEL = L1_Channel ll
r CIM_CUSTOMER L1_Tupe _|
r DIM_CUSTTYPE L1_CType _|
r CIM_PRODUCT L1_Product J
r DIM_REGION L1_Area ]
< Back et > Finigh | Cancel |

5. On the Measures page, select the measures.

VALUE is included by default. All numeric properties are available.

E_f, Hew Summary Report Defimtion =] B3
Measures
Select the measures.
Include | Meazurez
|7 WALUE
v Complaints
v Count
3 QUANTITY
r AMT
- Communication
Il CrossSell
Il Ihguiing
Il Hurnber
I Offer
[ Requests
¢ Back fHErt | Finizh I Cahcel
6. Click Finish.

The new report is added to the list of summary reports.
7. Select the new report in the list of summary reports, and then click Generate cube.

The cube is generated.
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E{E SAS Profitability Management - Bank_Model

File Edit %iew Actions Help

V| A X EL G| E & | Model [Bank_Model =

E. Reports
Workzpace: X Summary Reports I [etailed Reparts | Tazks = |

Show properties
SElect the summany report % & Free
Trahzactiohs X Remove...
Click Generate cube »-- | Generate cube.
A
EE Tﬁ& MNew report definition...
Rules

Behaviars Generating summary cube |
4 \i) Generating zummary cubes. ..
B

Fieports [ ({1 1]

Cancel

8. Click Details to view the message log.
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Add an Assignment Rule to a Transaction Table Group

1. Activate the Rules workspace, and then select a model.

2. Select File » Add Assignment Rule (or click the Add Assignment Rule icon
3.
The Add Assignment Rule window appears.

3. Name the rule.

4. Select the transaction table group to which you want to assign the rule.

5. Click Define to specify selection criteria.
The Selection Criteria window opens.

6. Select the columns in a transaction table group to include in a calculation.
You can specify three types of selection criteria:

o filter by text value

o filter by the value of one or more dimensions

o filter by numeric value

o filter by matching a field in the behavior table

a. Select one or more columns in the transaction table group.

b. Select an operator to apply to the selected columns.
« Textvalue operators: =, not =, match Behavior
= Numeric value operators: =, not =, <, <=, >, >= , match Behavior
« Dimension value operator: is child of

c. Select a value to compare the columns to.

d. Click Add New Row to add another condition to the selection criteria.
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Note: If you are using the match Behavior operator, then each condition
must be joined with the And operator.

e. Click OK.

7. After building the selection criteria, modify the conditions manually, as
necessary.

8. Select a numeric column to use in the driver formula.

Note: You are not restricted to a single field.

9. Click OK.

The assignment rule appears in the Rules workspace under the transaction
table group to which the rule belongs.
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Import a Rule Definition Table

1.

Activate the Rules workspace, and then select the model to which you want to
add the rule definitions.

. Select Actions k¥ Import Assignment Rules.

The Import Rules window opens.

. Click Select to select a rule definition table.

The Select Table window opens. Select a rule definition table, and then click
OK.

. To preview the data in the rule definition table, click Preview.

The Preview window opens and the rule definition table is displayed.

. Click OK.

For each required column in a rule definition table, identify the corresponding
column in the table that is being imported, and then click OK.

A window with the message Import assignment rules complete appears.

. Click Details to verify that the import succeeded, and then click OK.

Related Topics:

Export a rule definition table
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Import a Rule Definition Table

1. Activate the Rules workspace, and then select the model in which the rule definitions will be added.

[EZ sAs Profitability Management - BabyBank

File Edit Wiew Actions Help

Jﬁﬁ|| §§|E§@|%|%||Mudel: al:n,-'Bank

Select a model —
Workspacss X | salact table group:
| ABMCost | ~]
J Available rules:
Transactions Mame | Selection Criteria I Dirivel «
E§ ATM_CHEK_Check balance AssignmentRule = 'ATM_CHK_Check... AMT __
E§ ATM_CHK_Deposits AssignmentRule = 'ATM_CHK_Deposits’ | AMT
Rules workspace [*8 ATM_CHK_Fund Transfer AssignmentRule = 'ATM_CHK_Fund .., | AMT
E§ ATM_CHK_Requests IsChild2f{Channel, ‘[DIM_CHAMMEL]... | Cour
E§ ATM_CHK_Withdrawals AssignmentRule = "ATM_CHK_Withd.., | AMT
E§ ATM_CRC_Withdrawals AssignmentRule = 'ATM_CRC_Withd.., | AMT
) Eﬁ ATM_REC_Deposits AssignmentRule = 'ATM_REC_Deposits’ | AMT |«
Behaviors « | LI—I

2. Select Actions k Import Assignment Rules.

The Import Rules window opens.

Select Actions > Import Assignment Rules

E‘ESAS Profitability Management - BabyBar

File Edit View | Actions Help
| 8 | | Calculate Model

| Model;

m P Import Assignment Rules...”
M. | V3 Export Assinmmz
Workspaces =X —

E——— - Import Rules

‘_‘_‘_‘j = Import table: | |

Transactions Column mapping:

BrEsiet. .. |

=10l x|

Reguired Calumn | Impart From Calurnn

Marne
Selection Criteria
Driver Formula

Table Group Mame

Behaviors

Cancel

Q8




o Cancel |

3. Click Select to select a rule definition table.

The Select Table window opens. Select a rule definition table, and then click OK.
4. To preview the data in the rule definition table, click Preview.

The Preview window opens and the rule definition table is displayed.

5. Click OK.
1o x
Cliclk Select —Importisbla: I e || e | Ereview.., |

Column mapping: & Select Table

Required Column
Name Fepasitary: | {4 Foundation

Selection Criteria Axnailable tables:

Driver Formula El-{zp PM Model ﬂ
Table Group Mame | | § e £ ANALYSISTABLE

----- B ANALYSISTABLEMEASURE

----- EH AMALYSISTABLEFERIOD

Select a tahle

> ASSIGHNMENTRULE
----- EH] BEHAVIORASSIGHMENT
----- £ BEHAYIORTABLE
----- £ DATABASEVERSION ;I

ok | Concel | _|

6. For each required column in a rule definition table, identify the corresponding column in the table that is being
imported, and then click OK.

A window with the message Import assignment rules complete appears.
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Select each corresponding colurmn

=10l %]
Import table: | FE ASSIGNMENTRULE 1\ select... | Preview... |
Colurnn mapping: \
Required Column | Import From Column
Mame .{_5:}. Mame >
Selection Criteria é:},. SelectionCriteria ﬂ
Driver Farmula By DriverFarmula
Table Group Mame @ TableGroupld
MName | Description
{EﬁéNamE Mame
AR SelectionCriteria SelectionCriteria
@DriverFDrmula DriverFormula

7. Click Details to verify that the import succeeded, and then click OK.

SAS Prohtability Management - Bank_Model

\i‘) Irpart azsignment rules complete.

Click Details ok L copoClptesrdL I » Detaiecc |
Surmmarny: ﬂ
Total Succeeded: 574
Total Failed: 0

-
4] | 3

Related Topics:

. Export a rule definition table
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Add an Assignment Rule to a Transaction Table Group
1. Activate the Rules workspace, and then select a model.

[#2 SAS Profitability Management - BabyBank
Eile Edit WView Actons Help

J e3[4 78 |1a8 OF [ | 4 | 6

Select a model —

| Model: IBab\;Bank

Workspaes X | select table group:
| ABMCost | ~]
% Available rules:
Transactions Mame | Selection Criteria | Drive &
E§ ATM_CHE_Check balance AssignmentRule ="ATM_CHK_Chedk... AMT _
E§ ATM_CHE_Deposits AssignmentRule = "ATM_CHK_Deposits' | AMT
Rules workspace ——; [*8 ATM_CHE_Fund Transfer AssignmentRule ="ATM_CHK_Fund ... | AMT
[*8 ATM_CHK_Requests IsChildOf{Channel, '[DIM_CHAMMEL]... | Cour
E§ ATM_CHE_Withdrawals AssignmentRule = "ATM_CHK_\Withd... | AMT
Eﬁ ATM_CRC_Withdrawals AssignmentRule ="'ATM_CRC_Withd... | AMT
) [*8 ATM_REC_Deposits AssignmentRule = 'ATM_REC_Deposits' | AMT |w
Behaviors q I LI_I

2. Select File » Add Assignment Rule (or click the Add Assignment Ru

The Add Assignment Rule window appears.

Select File - Add Assignment Rule

[E7 5AS Profitability Management - Bank_Model M =]E3

File Edit “iew Actionf: Help

le icon @).

% Organize Models

| | #] | Model [Bank_Model

| Selection Criteria

Froperties ules |
Euit
ﬁ % buzz_Bark_Tranzactions
Transactions CallCerter

Revenue
[#-E7 Trans_TestFilker

1]

3. Name the rule.

4. Select the transaction table group to which you want to assign the rule.
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i Add Assignment Rule

narne the rule

Select the transaction takhle group
to which the rule is assighed

5. Click Define to specify selection criteria.

The Selection Criteria window opens.

¥ Add Assignment Rule

Mew_Rule

EREUEHL.IE

To define selection criteria
for transaction table rows,
click Define

¥ Selection Criteria - New assignment rule

6. Select the columns in a transaction table group to include in a calculation.
You can specify three types of selection criteria:
o filter by text value

o filter by the value of one or more dimensions

o filter by numeric value

o filter by matching a field in the behavior table

a. Select one or more columns in the transaction table group.



b. Select an operator to apply to the selected columns.
« Text value operators: =, not =, match Behavior
« Numeric value operators: =, not =, <, <=, >, >= , match Behavior

« Dimension value operator: is child of

Select the column ta filtker on
Select the filter operator Select a filter value

¥ Selection Criteria - New assignment rule

( | T N —
@ Select Dimension Member

E Agia Pacific
5, evea

Bl Morth America
E South America

c. Select a value to compare the columns to.
d. Click Add New Row to add another condition to the selection criteria.

Note: If you are using the match Behavior operator, then each condition must be joined with the And operator.

e. Click OK.

7. After building the selection criteria, modify the conditions manually, as necessary.
8. Select a numeric column to use in the driver formula.
Note: You are not restricted to a single field.

9. Click OK.
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¥ Add Assignment Rule - gl x|

Rule Mame:
I Mew_Rule

Step 1: Select a table group:

|Revenue | i |
Step 2: Set the selection criteria:
Edit as necessary —— | IsChidof{Region, '[DIM_REGION]. USA_SW]Y) ;I Define... |

Step 3: Define the driver formula:

~l
=l
Select 2 numeric field Column Name | Description
to use in driver formula ———L@hadr AMT i cancel

The added assignment rule displays in the Rules workspace under the transaction table group to which the rule belongs.

[E3 sAS Profitability Management - BabyBank o] x|

File Edit Wiew Actons Help

|68 A |Ba X %3 |80 & | & | E

Workspaes X |selact table group:

| Maodel: IBabyBank

Transaction table group |ABMC05t | LI
% Available rules:
Transactions
Fules a3 crK_chedbal | AssignmentRule = 'ATM_CHK_Chedk

E§ ATM_CHE_Deposits AssignmentRule = "ATM_CHK_Depos
Eﬁ ATM_CHE_Fund Transfer AssignmentRule = "ATM_CHK_Fund
[*8 ATM_CHK_Requests IsChildOf{Channel, '[DIM_CHANMEL]
Eﬁ ATM_CHE_Withdrawals AssignmentRule = "ATM_CHK_Withd
Eﬁ ATM_CRC_Withdrawals AssignmentRule = "ATM_CRC_Withd
[*2 ATM_REC_Deposits AssignmentRule ="ATM_REC_Depos
[*8 ATM_REC_Requests IsChildOf{Channel, '[DIM_CHANMEL]
E§ ATM_SAV_Chedk balance AssignmentRule = "ATM_SAV_Check
Eﬁ ATM_SAV_Deposits AssignmentRule ="ATM_SAV_Depos
[*8 ATM_SAY_Fund Transfer AssignmentRule = "ATM_SAV_Fund .
< N LI_I
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Associate an Assignment Rule with a Behavior

Because an assignment rule selects rows from a group of transaction tables, the effect
of associating an assignment rule with a behavior is associating the behavior with a
set of transaction table rows.

1. Activate the Behaviors workspace, and then select a model.
2. Select a behavior.

3. Click Create a new association (or click the Create a New Association icon,
or select File ¥ Create a New Association).

The Associate Rules window opens.
4. Select a table group.
5. Select additional behaviors to associate with a rule.
o Every behavior must be associated with a rule.
o A rule can be associated with multiple behaviors.
6. Select a rule to apply to the selected behaviors.
7. Click OK.

The new assignment rule displays in the Behaviors workspace.
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Import a Rule Association Table

1.

Activate the Behaviors workspace, and then select a model to which you want
to import the rule associations.

. Select Actions ¥ Import Associations.

The Import Associations window opens.

. Click Select to select a rule association table.

The Select Table window opens. Select a rule association table, and then click
OK.

. To preview the data in the rule association table, click Preview.

The Preview window opens and the rule association table is displayed.

. Click OK.

For each required column in a rule association table, identify the corresponding
column in the table that is being imported, and then click OK.

A window with the message Import associations complete appears.

. Click Details to verify that the import succeeded, and then click OK.

Notes:

If a column in the import table is blank, it is an error and the row is not imported.

If the assignment rule name in the import table is not found, it is an error and
the row is not imported.

If the table group name in the import table is not found, it is an error and the row
IS not imported.

If an association already exists for a behavior, the new association in the import
table replaces the existing association.

Related Topics:
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. Export a rule association table
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Import a Rule Association Table

1. Activate the Behaviors workspace, and then select a model to which you want to import the rule associations.

select a model

Behaviors workspace

E‘ESAS Profitability Management - BabyBank ;|g|5|
File Edit Wiew Actions Help
J % | | %ﬁ | o & | (75 | @ | |Model: IBaI:uyBank j
i Behaviors g '
Workspaces X ||_Behavior Id | Mame | Table Group | -
=1 10001 Credit Card interest Income 5 Revenue |
@ 10002 Loan Interest Income Revenue [
._‘_‘_j @ 10003 Maortgages Income Revenue
Transactions @ 11001 Savings Interest Payments Revenue
E111002 Certificates of Deposit Paym... Revenue
@ 11003 Investment Securities Paym... 5 Revenue
EE E112001 Credit Card Fees Revenue
Rules =1 12002 ATM Fees Revenus [
@ 12003 Investment Account Fees Revenue [
=1 12004 Checking Account Fees Revenue [
e =1 13001 Credit for Funds Revenue =
Eehavios :T . . LI—I

2. Select Actions ¥ Import Associations.

The Import Associations window opens.

Select Actions = Import Associations

E'E Export As=ociations. ..
Workspaes X ——

=
1 Import table: |

=101 %]

i Tl
able Group =

Bresview., . |

Behaviors

Transactions
Column mapping:
Required Column | Impaort From Column |
EE Behavior Id
Fules

Table Group Mame

Rule Mame
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3. Click Select to select a rule association table.

The Select Table window opens. Select a rule association table, and then click OK.
4. To preview the data in the rule association table, click Preview.

The Preview window opens and the rule association table is displayed.
5. Click OK.

=

Click Seleqt —  Imnart tshle: |

v

Column mapping: iifi Select Table
Required Column _
Behavior Id Repository: |@ Foundation | w |
Table Group Mame Available tables:
Fule Mame =l-{=P BNAC_Beg LI
----- 5| ASSOCIATION —
----- B BEHAVIOR
----- B CALLCENTER_Q1A
Select a tahle B CALLCENTER_Q1B
----- FH CALLCENTER Q2a
----- B CALLCENTER_Q2B |
= = . P
Ok I Cancel |

6. For each required column in a rule association table, identify the corresponding column in the table being imported,
and then click OK.

A window with the message Import associations complete appears.
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Select each corresponding column

B -~ Import Associations I |
Import table: | [ ASSOCIATION \ Select... | Preview. .. |
Column mapping: \

Required Column | Impaort From Column
Behavior Id B Behaviorld
Table Group Mame @Tal:uleGru:uup
Rule Mame B AssignmentRule
Mame | Description |
B Behaviorld Behaviorld
B BehavioriName BehaviorMame
@Tal:uleGru:uup TableGroup

AssignmentRule AssignmentRule

7. Click Details to verify that the import succeeded, and then click OK.

SAS Profitability Management - buzz_Sample Model

Ll
\!) Import azzociation: complete.

Click Details a L —coppiotipbomd——> Detalscc |
S Lmrnany: ﬂ
Total Succeeded: 267
Total Failed: D

Notes:

. If a column in the import table is blank, it is an error and the row is not imported.
. If the assignment rule name in the import table is not found, it is an error and the row is not imported.
. If the table group name in the import table is not found, it is an error and the row is not imported.

. If an association already exists for a behavior, the new association in the import table replaces the existing
association.

Related Topics:

. Export a rule association table
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Associate an Assignment Rule with a Behavior

1. Activate the Behaviors workspace, and then select a model.

[ 5AS Profitability Management - BabyBank =10l x|

File Edit Wiew Actions Help

J % | | %ﬁ | o & | (75 | % | |Mndel: IBaI:uyBank j
Select a model BElEvIioE -

Workspaces X ||_Behavior Id | Mame | Table Group | -
=1 10001 Credit Card interest Income £ Revenue |
=1 10002 Loan Interest Income Eﬂ Revenue [

._‘_‘_j @10003 Maortgages Income Eﬂ Revenue
Transactions @11001 Savings Interest Payments Eﬂ Revenue
E111002 Certificates of Deposit Paym... Eﬂ Revenue
@ 11003 Investment Securities Paym... Eﬂ Revenue
EE E112001 Credit Card Fees Eﬂ Revenue
Rules &1 17002 ATM Fees B2 Revenue [
=1 12003 Investment Account Fees Eﬂ Revenue I
=1 12004 Checking Account Fees Eﬂ Revenue [
Behaviors workspace =1 13001 Credit for Funds B2 Revenue =
Eehavios :T . . rm _;I_I

2. Select a behavior.

3. Click Create a new association (or click the Create a New Association icon, or select File » Create a New
Association).

The Associate Rules window opens.

E_‘E SAS Profitability Management - buzz_Sample Model

File Edt “iew Action: Help

J@| | g% | e | 3 | |Mu:u:|el: IBank_Mu:udeI j
‘workspaces X | Behaviors | Tasks x
Behavior |d | I ame : Sl emeEs
_ i =1 10001 Credit Card inte
Select a behavior —— 4 10002 Loan Interezt | [Elear assaEiation. .
Transactiors f=110003 baortgages Ino
=111001 Savings Intere: ] Import associations. ..
Click EE E1100z Certificates of [
Create a hew association " —1ong Lansstoncut 2o » 55 Lreate a new association,.,
HE =120 Credit Card Fee
=112002 ATH Fees
f=112003 |Fvestment Ao

i 17004 Cherking Arr
Behavions P 9

4. Select a table group.
5. Select additional behaviors to associate with a rule.

o Every behavior must be associated with a rule.
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o A rule can be associated with multiple behaviors.

6. Select a rule to apply to the selected behaviors.

7. Click OK.
< Associate Rules =] 3
Awailable behaviors: Agzociation:
| Behavior |d | I ame | Table group:
select a table group —— = ' i — |E|Bank_transactiuns |L|
Select additional hehaviors —ald &1 10002 Loan Interest Income _
O =1 10003 Maortgages Income Fule:
=1 11001 Savings |nterest Paym... EﬁEET_EHK_EDmpIaintS
Select a rule ———E1-E=3 44000 Sl Dot Cost bo Sustain Business
O =1 11003 [Fvestment Securities ...
O &3 120m Credit Card Fees
O &1 12002 ATM Fees
O =1 12003 [Fvestment Account F.. (&
4 | >

(] I Cancel Apply

The new assignment rule displays in the Behaviors workspace.

behawviar associated rule

E@ SAS Profitability Management - Bank_Model =] 3

File Edit “iew Acton: Help

|Be| [ |8% | B |G| | Model: [Bank_Model =]

wooravors | |
Workspaces X %&jhaviur Id | Mame |Tab|e Group -
10001 Credit Card interest Income - Revenue | |

=1 10002 Loan Interest Income E‘j Revenue

._‘_‘_j @10003 Maortgages Income E‘j Revenue

Tranzactionz @11001 Savings Interest Payments E‘j Revenue

[E11002 Certificates of Deposit Paym... E‘j Revenue

@11003 Investment Securities Paym... E‘j Revenue

EE E112001 Credit Card Fees E‘j Revenue

Flules &1 17002 ATM Fees B2 Revenue

=1 12003 Investment Account Fees E‘j Revenue

=1 12004 Checking Account Fees E‘j Revenue
= fE113001 Credit for Funds B2 Revenue -
Behaiars ;T I o Lrl
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’:H:‘ 5. Define Rules

An assignment rule associates rows in a transaction table with a behavior. An assignment rule:

. Is associated with one or more rows in a behavior table.
. Specifies which rows in a transaction table group to include in a calculation.

. Specifies what quantity to include in the calculation.

An assignment rule is implicitly associated with a single transaction table in a table group —
namely, the transaction table whose period is specified in the behavior table row with which the
assignment rule is associated.

Tahle group 1, P
Behawvior table Rules Transaction tahle,{fj_griuc_i_j}

D Namerﬁerinathawalue UnitValue | |ID TableGroup Criteria Formula | (CustlD' Amount
X Depnsh\_. 1/ %10 : 1 1 Amuunt 1 4
y Balance T . $2 2 2 CustlD=3 Amount 1 2
z Transfer 2 . $2 2 2 CustlD=3 Amount 3 1

Defining an assignment rule and associating it with a behavior is a two-step process.

1. Add an assignment rule to a transaction table group.

o One at a time

o By importing a rule definition table

2. Associate an assignment rule with a behavior.

o One at a time

o By importing a rule association table

Related Topics:

. Copy an assignment rule to a new name

. Clear an association between a behavior and an assignment rule

113



Suppress the Display of Blank Content

To suppress blank content, perform the following steps:

1. Log on to the SAS Web OLAP Viewer.
2. Select View k Preferences.

3. Select Suppress empty data.

a Preferences - Microzoft Internet Explorer provided by SAS

— Data and Yiewer Options

Layout: one column j

W suppress empty data

114



Insert a Graph into a Report

To insert a graph into a report, perform the following steps:
1. Log on to the SAS Web OLAP Viewer.

HEr b
l l Scatter Flot

2. Select a graph icon from the toolbar. 1 @ | #d B |~

BarLin; T T

Tile Line

The graph is inserted into the report.

Ml vige- Dita-  Procertes

LE_Pislin el Lids. | bt e Jiww Jwea | ek pina | Woms fos ks s
LY _Proid|  rieed bewes  (Telad | e Do | e |G 1 Torie  Juiai . | Tsa
e [

3. To change the formatting of the graph, click Properties, make changes, and then
click OK.
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il views Dataw Prngertiﬁs_

“:EI;EE_ <3 Properties - Microsoft Intemn. .. !
: ( Graph 1 Bar ] Axis ] Legend ]
PE Stvle: Custarn Rd
i —Colors
4Em_: =chetne: Pine -]
2E10 - Background: Iiﬁfv
0.00 —Depth
& 2D © 3D
e —Grid lines
Direction: INnne -]
Placement: & Back © Front
OK | Cancel

4. You can display the table and graph next to each other by selecting View »
Preferences and selecting two columns for the layout.
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SAS Webh OLAP Viewer - Unt

Filew Data~  Wiew= [T Query [IZ Navig

ey Mavigator Update Bookmark
CE?* Mew Bookmmark., ..
F5 Rows .
: Organize Bookmarks. ..
--ELnau:I_R
=+ Colurns Data Wiewer »
--ELnad_D
B slicer ||* applied Filters

[+ Drill Path

Refresh
Click Preferences r Preferences... %

T .

a Preferences - Microzoft Internet Explorer provided || [=] 3

—Data and Viewer Options

Lawout: one column j

ane colurmn
o columns

Select two columns [ Suppress empty d

The following picture shows the table and graph.
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Blview- fatar Propertes % X Muiews Dati- Properties .

.L;Ll_,nmht L2 Prafiy

| Credit Card
Imsterest
Incamie THIE, 184,571

| [f intarest | Loan

Incomrs | Interest
Incarme S149T 558002
Morigages

| Insme EHIT, 03, 267

| Total interest Income £3153545599
Saving:

Insterest
[ | S100,%24,28)
Credit far Funds

] interest ::““"'-'it:’ Punds ;

" Expanse | Depors Chargs Far Funds
Payments  $490,032,411 '
IngstmanT L
Socurities ) Crndiin Card Fras
Paymenls 510,389,358 :

i' Total Interest Expense S690, 048, 262 Foous el

| Net Interest Incoma 2462697637 [ |
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Change Heading Colors

To change the color of headings that are displayed in the SAS Web OLAP Viewer, perform
the following steps:

1. Log on to the SAS Web OLAP Viewer.
2. Click Properties in the report header.

3. Select the row, column, and measure heading colors.

Froperties —g=——-— Uata_p A X

L1 _Year 2006

- Table size
: Maximum rows to display: 0 -
- Maximum columns to display: |5 -

- Table headings
Row Heading Color: Automatic -

Column Heading Color:  |Automatic M.

Measure Heading Color: |Automatic M.

Gradient Colors:
Darker shades of selected colors will be used to indicate deeper levels.

™ Show colar gradients in row and column headings,

OK Cancel
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Drill into a Summary Report

. Dirill by columns

. Drill by rows
Drill by Columns

Drill by columns to see more detail in the time dimension.

Drill Path: # ¥ | Applied Filters
F views Dataw Properties £ X
Click to drill dowin into the year CTvear T 2006
L1_Profit LZ_Profit
Drill Path: # ¥ | Applied Filters:

L1_Year = 2004

B vieww Data= Properties

Click to expand
Lz Quarter [+ 2005_(:11\‘@ 2006 02 [FEEzo08 03 FE2

Click to drill daown
L1_Profit | LZ_Profit

Credit Card
interest

Income 4.7073E% 5.2193E9 5.7534E9 6

I Interest | 1 nan

>
X

Drill Path:
Click to drill out ———sel1_Year = 2006 = 2006_Q1

Drill by Rows
Drill by rows to see more detail in the contributing costs dimensions.
The levels that are available to drill down into for additional detail in the cube depend on the number of dimensions

levels that are selected in the_definition of the summary cube. The available depth to drill down into is limited by the
model's report hierarchy. In the following summary report, there are five levels of contributing costs:

1. L1_Profit = Sales and Marketing Effort
2. L2_Profit = Cost to Retain

3. L3 _Profit=CCT

4. L4_Profit= CRC

5. L5_Profit= CCT_CRC_Cross Sell - Up Sell

Click the down arrow at the bottom of the report to see the next page.
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F[3] Relationship Manszermen

T T Rowsl1-200f24 Bk

Click down arrow for next page

SAS Web OLAP Viewer - Untitled Data Exploration

Filew Dataw  ‘Wiew~ I]E-EINavigatnr & Bookmarks | il T B & i bl @ [ ki BB~ ¢

»
Drill Path: # X Applied Filters: & X

L1_Year = Z0O0&

f vieww Dataw Properties

Lz_quarter | [FF2o0s_01  [FE z2o06_g2 [+ & 2006_03
L1_Profit L2 _Profit L3_Profit | L4_Profit | L5_Profit
CCT_CRC_Crass
F@cre | sell - Up sell 208887 246880 249283
CCT_CRC_Offer 139258 164587 166164
[*][3 =CF.
[=IF cCT 313340 370327 70
[+ @] TPFP
=103 Cost RZ207 61717 62306
[=] 3] 5ales and to [+ [ TRAM
Viarketing Retain 24524 41168 41567
Effort
#BEIUCR 470035 FEEE1 8 FGOBIE

;W
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Format Displayed Numbers

You can define the display format for numbers to be used by default in SAS Profitability Management. To create a custom format for your numbers in
the SAS Web OLAP Viewer:

1. Open a summary report.

2. Select Data k Calculate New Measure.

The Calculate New Measure window opens.
3. Select the data item to be formatted, and then type a new name.
4. Click Select Format.

The Format window opens.

/4 Calculate New Measure - Microzoft Internet Explorer provided by SAS

Select 2 data item

N g Al
and type a3 name \—\b«‘—ﬂe———_—_—_blne e
Available data items: Expression:
QT <<root VALUES> [—
QUANTITY
REW
WALUE ﬂ

[
] =] ] L] [w] el

Hint: Enclose data items in << >3,

Functions: INDI‘IE j

Click Select Format Format: IDOLLAR!S.O =|Sn::ln::c:t___Fxn?_rmat...| Clear Format |

Mote ! If no format is specified, q default

Mew items:

Select a format

BEST Writes numeric values with a leading dollar
COMMA symbol {$), a comma that separates every three
CORM AR digits, and a period that separates the decimal
fraction

=
Valid width range: 2 to 32 I
Valid decimal range: 0 to (Width - 1) I

0K Cancel

5. Select a format to be applied, and then click OK.

6. Click Add to add the new item.
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Calculate Hew Measzure - Microzoft Internet Explorer provided by SAS

Name: newtialue

Available data items: Expression:
arr ceront VALUE>> =]
QUANTITY

i g i
] ] (2] ] 0] 2]

Hint: Enclose data items in << >3,

Functions: INone j

Format: IDOLLARE\.O ‘Seleci Fnrmat...l Clear Format ‘

Wate If no format is specified, a default format will be qssigned,

Mew items:

Click Add » Add
The itern is added newt'alus
Update
Delete
Click QK = 0K Cancel

7. Add the new item where you want to, and then remove the old item.

SAS Web OLAP Viewer - Untitled Data Exploration

Fllax Datas View= {1 Query| ¥R Navigator 8 Bookmarks M T B @ BiEue WA~
[ Query i
Selected Items: orill Path: 2 X Applied Filters:
=Eq Fows = | L1 _Year > 2006
SLREPORTHIERARCHY St
=49 Columns B view= Data=  Properties
S DIk_PERIOD I
U | L2_Quarter [MI2006_01 [ 2006 02
=g Slicer | .
Add the new itern  —— 9 Euewvalue Li_profit L2_Profit
&l Credit Card interast Income 17 a5 194 498.9
_I 175,345,996 5194,418,933
N —— -
Rernove the old iterm Bdd v Remove [f] Interest Income  Loan Interest Incame $313,210,457  $347,279,345
Available items: . o
Mortzages ncome $171,020,583 $189,823,032
£33 BEM_AN_Dim_Details -
BRya | UE Tatal Interast income $659,577,036 573,321,310
PERIOL Savings Intarest Payments §21,024,811  $23,311,745

[¥] interest Expense  Cartificates of Deposit Payments | £402,489,077  $113,637.137

'\ﬂlM_CHMJNEl, Investment Securities Payments 20,996,188 £23,280,010
:-"NM"EUSWMER Total Interest Expense $144,510,075  $160,228,892
S DIM_CUSTTYPE =l — ==
Net Interest Income S515,066,961  3571,092,418
Apply Reslore |
E Credit for Funds 383,280,842 592,342,588
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Select Specific Values to Display
To filter by value, perform the following steps:
1. Log on to the SAS Web OLAP Viewer.
2. Click the filter icon S on the toolbar, or select Data k Filters.

3. Select the dimension to filter by (row or column).

4. Select the values to include in the report, and then click OK.

3 Filters - Microsoft Internet Explorer provided|™ =] [E3

Show: FREPORTHIERARCHYSet
Condition: |I5 equal to |
—Value(s)

" Loan Interest Income
I rortgages [ncome
M Total Interast Income

""" I Savings Interest Payments

W Total Interest Expense
- Net Interest Income

n- N

Filter expression:
REPORTHIERARCHY et -l

QK | Cancel |

5. The resulting report lists the applied filters in the header of the report and
applies the filters.

Applied Filters: x X

REPORTHIERARCHYSet: Total Intereszt Income, Total
Intereszt Expenze, Met Interezt Income
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Open a Summary Report

Use the SAS Profitability Management Web Reporting Client to select a summary report for viewing. The report is viewed with the SAS
Web OLAP Viewer. To view a summary report, perform the following steps:

1. Log on to the SAS Profitability Management Web Reporting Client. User IDs and passwords were established during installation.
The exact URL to use depends on your server installation. A sample URL is the following:

http://profitmgmt:8080/SASProfitability/LogonCreate.do

SAS Profitability Management Gsas.
HEEEN ser name:
[
Password:

|

2. Click the Summary Reports tab.
3. Select a model.

4. Select a cube.

a SAS Profitability Management - Microzoft Internet Explorer provided by 5AS

File Edit ‘“iew Favorter Tool: Help | ‘.'
Addresz I@ http:/#abmabm ma sas com: 8080545 Profitability/G etSummanyR eports. do j Go

Log Off pmuser! | Help -

Profitability Management -+ Summary Reports Gsas.

Click the Summary Reports tab—Summary Reports |
Select a model——= todel: Bank_kodel v
A_Big_Bank =
AIRTIME TELCOM

Select a cube —— Available cubes:

| Eank_Regular
BEAMK.

IT BRMTimePr buzz_Bank_kodel BigBankE.A_Big Bank1

T buzz_new_model
I BPMTIMePH huzz_ Sample Mode. PigBankE A Big Bank2

Globus
Sabkd_Banlk
State of Texas x

|@ Log O I_ I_ ’_ I_ I_ |H Local intranet

Anakysis Table

T ePMTimern

HigBankE.A_Big Banks

[
4

The selected cube opens in the SAS Web OLAP Viewer. The SAS Web OLAP Viewer displays the profit-and-loss report. The default
configuration for the report is the following:

|Rows ’Report hierarchy dimension from SAS Profitability Management
|Co|umns ’Period dimension from SAS Profitability Management
Slicer Value - the cost and revenue properties from SAS Profitability

Management

For additional information about customizing profit-and-loss report in the SAS Web OLAP Viewer, see its online Help.
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AS Wehbh OLAP Yiewer for Java - Microzoft Internet Explorer provided by 5A5

File Edit ‘“iew Favontez Toolz Help |-Ir

@Eack - O T \ﬂ @ ‘_:]|/j__:'Search i}g‘Favuritea €}| < .,:H; - _J ﬁ ﬁ

Address |£_°| http: /4 abrnabm. na. sas. conm: 3080/545Web0 LAPYiewer Avisualdataexplorer. do?zaspfs_sessionid j Go

Profitability Manag f pruser! | Help = IS

SAS Web OLAP Viewer - Untitled Data Exploration Gsas.

Filew Dataw  ieww I3 Mavigator & Bookmarks il P B O3 il l @ L b
i Query «
Selacted Items: Drill Path: « X Applied Filters:
EHE5 Rows = -
T Load_ReportHierarchyset 1
EHER Columns B \ieww Dataw  Properties E
: % Lpad_Dimension_Period
Ereg slicer L1_vear [12006
~EBvaLLE = L1_Profit L2_Profit |
Add ~ Remove
Availabls [tems: Credit Card interest Income 2. 251E10
£5 BPMTimeProduct - Interest Income  Loan Interest Income -4 .dE10
Al UE
é----_'#_.Lnad_Dimension_Perind Mortgages Income 2233810
é----_l'_.Lnad_ReportHierarchySet Total Interest Income 7.9B3IZER
g----""F.Luad_Dimensiun_Prnduct Savings Interest Payments -2 £95E9

5----""F.LDad_ReportHierarchy =]
Interest Expense Certificates of Deposit Pavments 1 34p10
Apply | Restore ‘

Investment Securities Payments 2 g77E9

—_— .. P— hl
1| 3

|
[ 2] http:/abmmoe ha. 333 com B0B0/5A5 webD LAPYiewer/logoff.do l_ l_ ’_ l_ l_ % J Local intranet i
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Change the Number of Rows or Columns That Are Displayed

To change the number of rows or columns that are displayed in the SAS Web OLAP
Viewer, perform the following steps:

1. Log on to the SAS Web OLAP Viewer.
2. Click Properties in the report header.

3. Select the maximum number of rows and columns to display.

Froperties —g=——-— Uata_p A X

L1 _Year 2006

- Table size
: Maximum rows to display: 0 -
- Maximum columns to display: |5 -

- Table headings
Row Heading Color: Automatic -

Column Heading Color:  |Automatic M.

Measure Heading Color: |Automatic M.

Gradient Colors:
Darker shades of selected colors will be used to indicate deeper levels.

™ Show colar gradients in row and column headings,

OK Cancel
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Save a View of a Report
To save a view of a report, including its data and layout, perform the following steps:

1. Select File » Save As.
2. Select the location where you want to save the view.
3. Name the view.

4. Select Data Exploration as the type, and then click Save.

<3 SAS Web OLAP Viewer for Java - Microsoft Interng

File Edit “iew Favoitez Tools Help

Qo= - ) - Ix] (2] [

Address Iﬂj http: A abmabm. na. zaz.com: B080,/54 54 ebOLAFY |

S
e Search

aProfitability Management

SAS Web OLAP Viewer - savedREe

Filew Dataw Wiew~ | |[T]Query| Iz Mavigator &
| & Open... «
Zelect File = Save As Save As... % Drill Pa
p— | }

723 Save Az - Microsoft Internet Explorer provided by SAS

Select the location —hLucatinn:IF'MLlser*l j [£10p ane level T Show description
Marme £ Author  Date Modified Kewwords  Delete
(pata Explorations Q8F21/2006 []
Marme the view —s File name: 2006Report Save
select Data Exploration — sgave as Type: |Data Exploration j Cancel
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View System Information

To view system information, such as storage locations, perform the following steps:

1. Select Help ¥ About.
2. Click System Information.

The System Information window opens.

SAS Prohitability Management Syzstem Information

E rrvironment infarmation

Froperty Y alue

Operating Spztem Windaws P

05 User buborc

Server abrimoe. hia. sas. com

Location of models C:ASA5%Profitabilityhd anagerment' 0 atatiersd o
Location of [nformation Mapz | /Profitabilitybd anagement 4 odels

Location of cubes C:\S5A5MProfitabilitytd anagerment O LAPHerC
D atabaze Library C:ASA5%Profitabilityhd anagerment'. D atatier P
JOBC Driver url jdbic: zaziom: A abmmoe. na.sas. com: 8591

J | i

Product infarmation

M arne Y alue

Product M ame 545 Profitability b anagement
Product Wersion 1.2.0.0. 20067006, 5626

P Uzer prouzer

4| | ]

aK |
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Select the Periods Whose Transaction Tables Are Included in
Cubes

Each transaction table is associated with only one period. To select the periods whose
transaction tables are to be included in any cube that is generated from the model,
perform the following steps:

1. Activate the Transactions workspace, and then select a model.

2. Click Change analysis settings, or select Edit » Analysis Settings.
The Analysis Settings window opens.

3. Click the Periods tab.

4. Select the periods whose transaction tables are to be included in a cube.

Note: Any period that is to be included in a cube must have been selected for
calculation when you calculated the model.

BE Analyszis Settings N =]

Fenods | Meazures I

% |nclude tranzaction tables from all periods

" |nclude tranzaction tables from selected periods:

Actual > 2006 > 2006 01
Budget > 2006 » 2006_(11
Actual > 2006 > 2006 02
Budget > 20085 » 2006 02
Actual > 2006 > 2006 03
Budget > 2006 > 2006 (3
Actual > 2006 > 2006_04
Budget > 2005 > 2006_(14

EEEREREEE
0 0 i i e i e

k. Cancel
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Clear Associations

To clear an association between an assignment rule and a behavior, perform the
following steps:

1. Activate the Behaviors workspace, and select a model.
2. Select a behavior.
3. Click Clear association, or select Edit ¥ Clear Association.

4. Click Yes.
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Copy an Assignment Rule to a New Name

To copy an assignment rule to a new name, perform the following steps:

1.

2.

Activate the Rules workspace, and then select a model.

Select the assignment rule to be copied.

. Click Copy assignment rule, or select Edit ¥ Copy Assignment Rule.

The Copy Assignment Rule window opens.

. Type the new name of the assignment rule.
. Select the transaction table group to which the assignment rule applies.

. Click OK.
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Delete All Assignment Rules

To delete all assignment rules, perform the following steps:

1. Activate the Rules workspace, and select a table group.

2. Click Delete all assignment rules, or select Edit » Delete all assignment
rules.
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Add a New Period to the Period Dimensions Table

1. Use SAS Table Editor, SAS Enterprise Guide, or another editor to add the period to the dimension table.

Note: After modifying the table, you must use SAS Management Console to re-import it into your input directory. Importing does not copy
the file itself — it updates the metadata maintained by the SAS Management Console.

= viEwTABLE D period =Y
1D | L1 Scenario | L2 Year | L3 Quarker =
1 2006_01_sAchual Actual 2006 2006_01
2 2006_Q2_Actual  Actual 2006 2006_02
3 2006_03 Actual Actual 2008 2006_(3
4 2006_G4 Actual  Actual 2006 2006_04
5 2006_(1_Budget  Budget 2008 2006_01
f 2006_02 Budget  Budget 2006 2006_02
7 2006_Q3 Budget  Budget 2006 2006_03 e
MNews period —s 8 2006_04_Budget  Budget 2006 2006_04 -
r— | s

2. Activate the Transactions workspace.

3. Select the model that contains the period dimension table.

4. Select Actions » Refresh to add the period to the list.

t‘."@ SAS Profitability Management - Bank_Model

File Edit “iew | Action: Help

J Lj i | | Calculate Model || M odel: IBank_ModeI j

Select Actions > Refresh ——

B Refresh
Workspaces X Transactinnsl

M arne | Feriod

(i

5 CalCenter
Revenue

E‘j “Web Costs

1| | i

5. Click Change analysis settings and verify that the new period is listed in the Analysis Settings window.

Note: The periods listed under analysis settings are the periods that are to be included in a cube. Any period that is selected for inclusion
in a cube must have been selected at some point when you calculate the model (see step 8 below).
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Transactions
Workspaces X | Transaclions | Tasks x |
@ Nam I Prato Show properties
Click Change analysis settings ) Chanae analysis settings
- Tranzaciziig Revenue
[+ Web Costs o TS
EE _----"__-_--__ ' Ad tahle Arnon
Rules B Analysis Settings [ =]
a Feriods | Mea$ures|
Behaviors % |nclude transaction tables from all periods
1 I " |nclude transaction tables from selected periods:
= —_— B Actual > 2006 > 2006_01 H
B Budget > 2006 > 2006_{1
B Actual > 2006 > 2006_02
8 Budgst > 2006 > 2006_02
B Actual > 2006 > 2006_03
B Budgst > 2006 > 2006_03
_ B Actual > 2006 > 2006_04
Mews period 7] B Budget » 2006 » 2006_04
Ok I Cancel

E"‘E SAS Profitability Management - Bank_Reqgular

File Edit ‘“iew Help

[REREA RN e T

|M0del: IBank_Fiegulal

6. Add rows for the new period to the behavior table.

Tine I | Name ule | Totahvshee| Unitishe
1787 | 2006_Q4_Budget 20010  ATHM_SAV_Check balance ATM_SAV_Check balance 1] 2.279572
1788 | 2006_04_Budget 200171  ATM_SAV_Deposits ATM_SAY_Deposits a 031203
1789 | 2006_04_Budgst 20012 ATM_SAV_Fund Transier ATM_SAW_Fund Trarsfer 0 1.260127
1790 | 2006_04_Budget 20013  ATM_SAV Withdiawals ATM_SAV Withdeawals 0 B.172056
1791 | 2006_U4_Budgst 20014  ATM_TRM_Deposits ATM_TRM_Deposits 0 0064873
1792 | 2006 04_Budgst 20015  ATM_TRM_\Withdrawals ATM_TRM_'withdrawals 0 1.39023
1793 | 2006_(04 Budgst 20016  BRH_CHF_Check balance BRH_CHE,_Check balance 1] 12711627
1794 | 2006 (4 _Budost 200017 BRH_CHE_Deposts BRH_CHF._Deposis 1] 372385
1795 | 2006_04_Budget 20018 BRH_CHE_Fund Transfer BRH_CHE_Fund Transler [i] B.028322
1736 | 2006 04 Budget 20019 BRH_CHE_Other Transactions  BRH_CHE_Other Transactions E36438 0
1797 | 2006_Q4_Budgst 20020  BRH_CHE_Withdrawals BRH_CHE,_Withdrawals 0 19.99321
1798 | 2006_04_Budgst 20021  BRH_CRC_Oweidue payment BAH_CRC_Owverdus payment 1] N0
1799 | 2006_Q4_Budget 20022 BRH_CRC_Repayment BRH_CRC_Repayment 0 45, 48266
1800 |2005_04_Budget 20023 BRH_FBP Manage ranzactions BRH_FBP_Manage transactions 1.351E7 o
1801 | 2006_04_Budget 20024 BRH_OTP_Manage ianzachon: BRH_DTP_Manage ansachons BISET 1]
1802|2006 04_Budget 20025 BRH_OVD_Repapment BRH_OWD_Repapment 0 101.8%48
1803 | 2006_04_Budget 20028 BRH_REC_Deposis BRH_REC_Deposits 1] 1.79712
16804 |2006 04 Budget 20027 BRH_REC Withdrawalz BRH_REC_Withdrawalz a 0.905413
1805 | 2006_(4_Budget 20028 BRH_S&V_Check balance BRH_SAY_Check balance 0 30.02252

7. Add transaction tables to all of the table groups.

When you add a transaction table to a transaction table group, you must assign a period to each transaction table.

Note: Each transaction table in a model can have only one period. And, each period in a model can have only one transaction table. (If you
encounter the error Several transaction tables are assigned to the same period, it is because a transaction table exists in the table
group that is assigned to that period.)

Calculate the model.

Only new periods need to be calculated.
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9. Calculate the summary cubes.

Clicking Generate cube will process all periods because the cubes are made across multiple periods.

b BNE_ANDi Fullelais Mode!_B
[ BNE_AN_Dien_Tops BankMode!_BNEAIDimT ops
B BHE_ BarkModel BNEARDimARMeasuses
BankModel_BNE TimeProf
{8 BNEK_Time_Proft_Channel BankModel BMK TimeFroftChannel
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Working with Behaviors

. Clear an association

. Associate an assignment rule with a behavior

. Import a rule association table

. Copy an assignment rule to a new name
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Working with Cubes

. Generate a cube

. Edit the properties of a cube

. Select the periods whose transaction tables are included in cubes

. Define the display format for numbers

. View a cube (summary report)

. Format displayed numbers
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Define Reports

. Define a summary report

. Define a detall report

. Add labels to a report

. Define the display format for numbers

139



View a Detail Report

Profitability Management - Detailed Reporis SSEIS.

AGIERTETLIecll Detailed Reports

Use the SAS Profitability Management Web Reporting Client to select a detail report
for viewing. The report is viewed with the SAS Web OLAP Viewer.

. Open a detall report

Drill into a detail report

. Suppress the display of blank content
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Working with Dimensions

. Add a new period to the period dimensions table
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Working with Models

Create a new profitability model

Calculate a model

. Edit a model
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Working with Reports

Define Reports

. Define a summary report

. Define a detall report

. Add labels to a report

. Define the display format for numbers

View Summary Reports

. Open a summary report

. Drill into a summary report

. Suppress the display of blank content

. Select specific values to display

. Change the number of rows or columns that are displayed

. Change heading colors

. Format displayed numbers

. Insert a graph into a report

. Save a view of a report

View Detail Reports

. Open a detall report

. Drill into a detail report

. Suppress the display of blank content
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Working with Rules

. Add an assignment rule to a transaction table group

. Import a rule definition table

. Export a rule definition table

. Associate an assignment rule with a behavior

. Import a rule association table

. Export a rule association table

. Copy an assignment rule to a new name

. Clear an association
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Set Up the Environment

. Populate the input directory

. ldentify input and output directories to SAS Profitability Management

. Import tables into the input directory

. Add users

. Configure the server

. View system information
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View a Summary Report

Profitability Management - Summary Reports SSE!S

Summary Reports EEENENERET T gss

Use the SAS Profitability Management Web Reporting Client to select a summary
report for viewing. The report is viewed with the SAS Web OLAP Viewer.

. Open a summary report

. Drill into a summary report

. Suppress the display of blank content

Select specific values to display

Change the number of rows or columns displayed

. Change heading colors.

. Format displayed numbers.

. Insert a graph

. Save a view of a report
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Working with Transactions

. Define a transaction table group

. Select the periods whose transaction tables are included in cubes

. Define the display format for numbers
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Tasks

. Set up the environment

. Working with behaviors

. Working with cubes

. Working with dimensions

. Working with models

. Working with rules

. Working with transactions

. Working with reports
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Define the Display Format for Numbers

The format of a numeric field determines how it is displayed in a report. To define the format of a numeric field, perform the following steps:
1. Activate the Transactions workspace, and then select a model.
2. Click Change analysis settings, or select Edit » Analysis Settings.
The Analysis Settings window opens.
3. Click the Measures tab.
All available numeric fields in the model are listed.

Note: Two numeric fields with the same name in different transaction table groups are considered to be the same field and are joined in the same data column in the
final analysis view.

4. Specify a SAS numeric format.

BESTw Best available format with width=w
COMMAw.d Comma and decimal points with width=w and decimal=d
COMMAXw.d Comma and decimal points with width=w and decimal=d (switches the role of comma and decimal points)
DOLLARw.d Dollar signs, comma, and decimal points with width=w and decimal=d
DOLLARXw.d Dollar signs, comma, and decimal points with width=w and decimal=d (switches the role of comma and decimal points)
EUROw.d Euro signs, comma, and decimal points with width=w and decimal=d
EUROXw.d Euro signs, comma, and decimal points with width=w and decimal=d (switches the role of comma and decimal points)
PERCENTw.d Percentage with width=w and decimal=d and a percentage sign
Zw.d Prefixed with zero to get width=w and decimal=d
w.d width=w and decimal=d
BF Analysis Settings 8 [=]

Periods  Measures I

Format measures:

Meazure | 545 Mumeric Fomat
AMT 8.2

Count 8.2

QUANTITY 8z

WL LE DOLLAR15.2

OK I Cancel

5. Click OK.
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Toolbar for Behaviors

Fille Edit View Actions Help
|Bg |2 8880 |72 | @ | & | &
(click the toolbar)

=

Bebawvions

%

ooo

Create a New Association

Opens the Associate Rules window.

Available behaviors - The list of behaviors

Select table group - The list of table groups for the rule source
Apply rule - The list of rules

OK - Apply the selections and close the window

Cancel - Cancel the selections and close the window
Associate -

Disassociate -

Properties

Displays the properties for the selected items.
General tab
Name - The name of the behavior

Reference - The ID for the behavior
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Association -

83| Clear Association

Clears the assignment rule association from the behavior.

@Clear all associations

Clears all assignment rule associations from all behaviors.

ooc

E Import Associations
Opens the Import Associations window.
Import table - The source table in which you have created your associations
Select -
Preview -
Column mapping
Behavior Id - The text property that defines the behavior
Table Group Name - The table group for the rule source
Rule Name - The name of the rule to map to the behavior
OK - Accept changes and close the window

Cancel - Cancel changes and close the window
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= .
B Export Associations

Opens the Export Associations window.
Table Name -
Savein -
Select -
OK -

Cancel -

J Organize Models
Opens the Organize Models window.
Models - Select the model from the list
New Model - Start the Add Model wizard
Properties - Display the properties for the selected model
General tab

Name -

Description -

Time dimension -

Select -

Preview -
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Analysis tab
Analysis view name - The name for the model
Analysis view library -
Select -
Output table library -
Select -
Data Location tab
Server folder -
Metadata folder -
Behavior Table tab
Behavior table -
Select -
Preview -
Column mapping
Id - The key that will be used to map cost to reporting
Name - The description for the field

Unit Value - The source unit cost amount that is used in
calculations

Total Value - The source total cost amount that is used in
calculations

Period -
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Dimensions tab
Name - Each dimension in the SAS Profitability Management model
Levels - Each layer in each dimension
Preview -
Add -
Remove -
Reports tab

Report hierarchy - The source table that is used to define the drill-
down hierarchy in the contributing cost dimensions for reporting

Select -
Preview -

Report layout - The source table that is used to define the
calculation for the profit and loss statement

Select -
Preview -
OK -
Cancel -
Delete - Remove the selected model

Close - Close the window
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‘B?Audit Log

Opens the Audit Log window.

Calculate Model

Opens the Calculate wizard.

Refresh

Refreshes the screen to display the current table source data. When you change the
underlying SAS tables, you should always refresh before you continue editing the
content in SAS Profitability Management.
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Toolbar for Reports

File Edit View Actions Help

ol [ X|EB D& E

FI E!FII:III::E:
(click the toolbar)

.:.'Ib,
@ New Summary Report Definition

Opens the New Summary Report Definition wizard.

Properties

Displays the properties for the selected items.
General tab

Location - The location of the summary report; the default location is /
ProfitabilityManagement/models/<Your Model>/Reports

Report definition name - The name of the summary report
Dimensions and levels tab

Include - Select to include dimensions in the model

Dimensions - The dimensions in the model

Allow Drill Down To - Select a level to view for each dimensional hierarchy
in the summary report; the default is level 1 for period and level 2 for report
hierarchy

Measures tab

Include - Select to include which numeric values are displayed in the
summary report
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Measures - All available numeric properties

E Remove

Deletes the selected items.

@ Generate Cube

Generates a cube. After the cube is generated, adialog box is displayed.
OK -
Copy to Clipboard -

Details -

ﬂ Organize Models

Opens the Organize Models window.
Models - Select the model from the list
New Model - Start the Add Model wizard
Properties - Display the properties for the selected model
General tab
Name -

Description -
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Time dimension -
Select -
Preview -
Analysis tab
Analysis view name - The name for the model
Analysis view library -
Select -
Output table library -
Select -
Data Location tab
Server folder -
Metadata folder -
Behavior Table tab
Behavior table -
Select -
Preview -
Column mapping
Id - The key that will be used to map cost to reporting
Name - The description for the field
Unit Value - The source unit cost amount that is used in

calculations
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Total Value - The source total cost amount that is used in
calculations

Period -
Dimensions tab
Name - Each dimension in the SAS Profitability Management model
Levels - Each layer in each dimension
Preview -
Add -
Remove -
Reports tab

Report hierarchy - The source table that is used to define the drill-
down hierarchy in the contributing cost dimensions for reporting

Select -
Preview -

Report layout - The source table that is used to define the
calculation for the profit and loss statement

Select -
Preview -
OK -
Cancel -

Delete - Remove the selected model
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Close - Close the window

@‘Audit Log

Opens the Audit Log window.

Calculate Model

Opens the Calculate wizard.

Refresh

Refreshes the screen to display the current table source data. When you change the
underlying SAS tables, you should always refresh before you continue editing the
content in SAS Profitability Management.
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Toolbar for Rules

File Edit View Actions Help
|08 A | X %3 #E 08 |5 | & &
(click the toolbar)

E Add Assignment Rule
Rule Name - The name of the assignment rule

Step 1: Select a table group - The assignment rule will be assigned to all
transactions in this group

Step 2: Set the selection criteria - The selection criteria defines which records in the
source transaction tables will receive assigned costs from a specific source account

Define - Opens the Selection Criteria window
Column name - Column to filter from source table
Operator - Filter
Text Fields Operators: =, not =
Numeric Fields Operators: =, not =, <, <=, >, >=
Dimension Fields Operator: is child of
Value -
Select -
Text Field: List of all text values in the source table
Numeric Field: List of all numeric values in the source table

Dimensional Fields: Dimension member from dimensional
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hierarchy; the is child of operator includes a member in the
hierarchy and all children of the selected member in the filter

Add New Row -
Compound Filter Options - And or Or
Step 3: Define the driver formula - The driver formula defines how much of a source

account is assigned to a destination account that has been selected by the filter; this
definition is based on the source transactional table quantities and values

7] Properties

Transaction Table - General tab
Table group name
Description

Transaction Table - Columns tab
Include
Source column
Description
Category

Assignment Rule - General tab
Rule Name - The name of the rule
Step 1: Select a table group

Step 2: Set the selection criteria
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Step 3: Define the driver formula

% Copy Assignment Rule
Opens the Copy Assignment Rule window.
Name - The name of the copied assignment rule

Location - The table group in which to place the assignment rule in

E Remove

Deletes the selected items.

L Delete All Assignment Rules

Deletes all assignment rules.

E Import Assignment Rules
Opens the Import Rules window.
Import table - Source table in which rules are defined
Select -
Preview -
Column mapping
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Name - The name of the rule that is being defined
Selection Criteria - The filter criteria for the rule definition

Driver Formula - The numeric properties that are defined for the
driver formula

Table Group Name - The table group in which the rule will be
applied

OK - Accept changes and close the window

Cancel - Cancel changes and close the window

—"EExport Assignment Rules
Opens the Export Rules window.
Table Name -

Savein -

Select -

J Organize Models

Opens the Organize Models window.
Models - Select the model from the list
New Model - Start the Add Model wizard

Properties - Display the properties for the selected model
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General tab
Name -
Description -
Time dimension -
Select -
Preview -
Analysis tab
Analysis view name - The name for the model
Analysis view library -
Select -
Output table library -
Select -
Data Location tab
Server folder -
Metadata folder -
Behavior Table tab
Behavior table -
Select -
Preview -

Column mapping

166



Id - The key that will be used to map cost to reporting
Name - The description for the field

Unit Value - The source unit cost amount that is used in
calculations

Total Value - The source total cost amount that is used in
calculations

Period -
Dimensions tab
Name - Each dimension in the SAS Profitability Management model
Levels - Each layer in each dimension
Preview -
Add -
Remove -
Reports tab

Report hierarchy - The source table that is used to define the drill-
down hierarchy in the contributing cost dimensions for reporting

Select -
Preview -

Report layout - The source table that is used to define the
calculation for the profit and loss statement

Select -

Preview -
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OK -

Cancel -

Delete - Remove the selected model

Close - Close the window

’Q"Audit Log

Opens the Audit Log window.

Calculate Model

Opens the Calculate wizard.

Refresh

Refreshes the screen to display the current table source data. When you change the
underlying SAS tables, you should always refresh before you continue editing the
content in SAS Profitability Management.
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Menus and Toolbars

Menus
Menus for Transactions

File Edit “iew Actions

Menus for Rules

Fie Edit “iew Actiohs

Menus for Behaviors

ﬁ File Edit “iew Achons

Hehavions

Menus for Reports

? File Edit “iew Achons
Ll

Heparts

Help

Help

Help

Help

Toolbars
Toolbar for Transactions

EEE]
S

P8 X %ol o & E

i
E£3
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Toolbar for Transactions

File Edit View Actions Help

‘ RERENRER S SRR RN AR N e

(ransactions
(click the toolbar)

ﬂ Add Table Group

Opens the Add Table Group wizard.

Add Transaction Tables

Opens the Add Transaction Tables wizard.

Properties

Transaction Table - General tab
Table group name
Description

Transaction Table - Columns tab
Include
Source column
Description
Category

Transaction Table: General tab

170



Name - The name of the source table
Repository - The source table repository
SAS libref - The source table SAS libname
Table name - The name of the source table

Period - The correct period for this source table

E Remove

Deletes the selected items.

E Analysis Settings
Opens the Analysis Settings window.
Period tab

Include transaction tables from all periods

Include transaction tables from selected periods
Measures tab
Format measures

Measure

SAS Numeric Format - The display format for the reporting
OK - Accept any changes and close the window

Cancel - Cancel changes and close the window
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‘E’Audit Log

Opens the Audit Log window.

J Organize Models
Opens the Organize Models window.
Models - Select the model from the list
New Model - Start the Add Model wizard
Properties - Display the properties for the selected model
General tab
Name -
Description -
Time dimension -
Select -
Preview -
Analysis tab
Analysis view name - The name for the model
Analysis view library -
Select -
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Output table library -
Select -
Data Location tab
Server folder -
Metadata folder -
Behavior Table tab
Behavior table -
Select -
Preview -
Column mapping
Id - The key that will be used to map cost to reporting
Name - The description for the field

Unit Value - The source unit cost amount that is used in
calculations

Total Value - The source total cost amount that is used in
calculations

Period -
Dimensions tab
Name - Each dimension in the SAS Profitability Management model
Levels - Each layer in each dimension
Preview -

173



Add -
Remove -
Reports tab

Report hierarchy - The source table that is used to define the drill-
down hierarchy in the contributing cost dimensions for reporting

Select -
Preview -

Report layout - The source table that is used to define the
calculation for the profit and loss statement

Select -
Preview -
OK -
Cancel -
Delete - Remove the selected model

Close - Close the window

J Calculate Model

Opens the Calculate wizard.

ﬂ Refresh

Refreshes the screen to display the current table source data. When you change the
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underlying SAS tables, you should always refresh before you continue editing the
content in SAS Profitability Management.

E-Preview Data

Opens the Preview window.
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Add Transaction Tables to a Table Group

To add transaction tables to a table group, perform the following steps:

1. Activate the Transactions workspace, and then select a model.

2. Select a transaction table group to which you want to add transaction tables.

3. Click Add transaction tables, or select File » Add Transaction Tables.
The Add Transaction Tables wizard opens.

4. On the Transaction Tables page, select the transaction tables to add to the
table group.

5. Click Add.
6. Repeat steps 4 and 5 as necessary.

7. To preview the data in a transaction table, select a table from either list, and
then click Preview.

The Preview window opens and the transaction table is displayed.
8. Click OK, and then click Next.
9. On the Period page, assign a period to each transaction table.

Note: Each transaction table in a model can have only one period. And, each
period in a model can have only one transaction table. (If you encounter the
error Several transaction tables are assigned to the same period, itis
because a transaction table exists in the table group that is assigned to that
period.)

10. Click Finish.

11. Transaction tables that have been added to a table group are displayed under
the table group name in the Transactions workspace.
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Add Transaction Tables to a Group

1. Activate the Transactions workspace, and then select a model.

File Edit View Actions Help

FENCTIEND ST

Select a model

Transactions workspace —

[#3 sAs Profitability Management - BabyBank

Transactions

Workspaees X
F-{ ABMCost

& callcenter
B Revenue

Behaviors

ol

Show properties

X Remaove,

@ Change analysis settings. ..

ﬁ% Add table group. ..
Add transaction tables. ..

I'Z| Preview Data

2. Select a transaction table group to which you want to add transaction tables.

3. Click Add transaction tables, or select File » Add Transaction Tables.

The Add Transaction Tables wizard opens.

Select a table group H

Click Add transaction tables

E‘_‘_;SAS Profitability Management - BabyBank

File Edit View Actions Help

J%||X|@|%|®| '_-':"||Modv.=.4: IBab\,-'Bank

Transactions

| Perind

Workspaees X

Transactions

>3

Rules

Tasks

Show properties

X Remove...

@ Change analysis settings...

iﬁ Add table group. ..
Add transaction tables. ..

Behaviors

|'Z| Preview Data

4. On the Transaction Tables page, select the transaction tables to add to the table group.

5. Click Add.

6. Repeat steps 4 and 5 as necessary.
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10.

i) Add Transaction Tables - CallCenter

Transaction Tables
Select transaction tables.

Grarosr |y

FM bigbank Input Tables - Lib [ CALLCENTER Q44
- ASSOCIATION , B CALLCENTER Q48
B8 CALLCENTER_Q1A
-8 CALLCEMTER_Q1B

Select transaction :ﬂ CALLCENTER_Q2A

tables to add

-E] CALLCEMTER_Q3B

B8 LoAD_BEHAVIOR

B3 LOAD_DIMENSIOM_CHAMMEL

- LOAD_DIMENSION_CUSTOMER

B8 LOAD_DIMENSION_CUSTTYPE

- LOAD_DIMENSION_PERIOD

- LOAD DIMENSIOM PRODUCT 7|

To preview the data in a transaction table, select a table from either list, and then click Preview.
The Preview window opens and the transaction table is displayed.

Click OK, and then click Next.

. On the Period page, assign a period to each transaction table.

Note: Each transaction table in a model can have only one period. And, each period in a model can have only one transaction
table. (If you encounter the error Several transaction tables are assigned to the same period, it is because a transaction table
exists in the table group that is assigned to that period.)

Click Finish.
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Period
One or more transaction tables have not been assigned to a period.

CALLCEMNTER _Q4A Actual > 2006 = 2006_04
CALLCEMNTER _Q4B
5 actual
= E Budget
Assion a period for B B 2008
each transaction table a mns_qk

11. Transaction tables that have been added to a table group are displayed under the table group name in the Transactions
workspace.

[#3 sas pProfitability Management - BabyBank O] =

i E CallCenter
Added transaction tables
are displayed here -] CALLCENTER_Q4A

‘Iransactions : CALLCENTER._Q4B
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Define a Transaction Table Group

To define a transaction table group, perform the following steps:

1.

Activate the Transactions workspace, and then select a model.

. Click the Add Table Group icon ﬂ

The Add Table Group wizaard opens.

. On the Information page, name the table group, and then click Next.

. On the Transaction Table page, select the transaction table whose layout

defines the layout (the required fields) for this group.

. Click Next.

. On the Categorize Columns page, associate each source column (in the

transaction table) with its corresponding dimension table.

Note: Clear the time dimension. Because each transaction table is matched to a
single time dimension, you do not have to associate each transaction table with
the entire time-dimension table.

. Click Finish.

. The transaction table group is added to the model.
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Define a Transaction Table Group

1. Activate the Transactions workspace, and then select a model.

[EZ sAs Profitability Management - BabyBank o =]

File Edit View Actions Help

1o Fa | (A | X |6 [ | R

Transactions

Workspaees X

Select a model

CallCenter Show properties

[ Revenue

Transactions WDI’KS[CIECE R
}( Remove...

@ Change analysis settings. ..

i"ﬁ] Add table group...
Add transaction tables...

|'Z| Preview Data

Behaviors P | _’I

i
2. Click the Add Table Group icon ﬂ
The Add Table Group wizard opens.

3. On the Information page, name the table group, and then click Next.

E‘E SAS Profitability Management - Bank_Model
File Edit “iew Help

Click the Add Table Group icon — % &4 I 2|5 | Model: [Bark_Madel

Transactions

Tranzartinns I

E"ﬁ Add Table Group M=]E3

Information

Workspaces

Twpe a name for the table group.

MName the table group » Table group name:  |Bank_Transactions

Rules Description:

Behaviors
e ——— < Hack I Mexst » I Frmrsty | Cancel |

4. On the Transaction Table page, select the transaction table whose layout defines the layout (the required fields) for this group.

5. Click Next.
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& Add Table Group _ (3] =]

Transaction Table
Select a tranzaction table to base the tranzaction table group schema on. ‘

Repositon: |@ Foundation | Ll

Tranzaction table:

..... B DIM_FRODUCT -l
----- 4 DIM_REGIOM

Select a transaction table | A [

----- £ LOAD_TRANS_Q1B

-
FH I nAn TOAMCS M4 J

< Back I Meut » I FErrimetT | Cancel |

6. On the Categorize Columns page, associate each source column (in the transaction table) with its corresponding dimension
table.

Note: Clear the time dimension. Because each transaction table is matched to a single time dimension, you do not have to
associate each transaction table with the entire time-dimension table.

7. Click Finish.

& Add Table Group

Categorize Columns

Select calumns ta define the schema and categorize the column.

Colurmns in transaction table "'-1-..____“___‘_‘_

|nclude |-§'|:uun:e column | D ezcription | Categony |
W AMT AMT {2 Mumeric ~|
v AgzignmentRule AgzignmentRule @ Text il
¥ Channel Channel CF DIM_CHANMEL ll
¥ Count Count iz Mumeric ll
M | CustD CustiD CPDIM_CUSTOMER |
W CustTupe CuztTupe {fg;. Teut ﬂ
~ Product Product |j_J DIM_PRODUCT hd
v Reqion Reqion |j_-J DIM_REGION b
I Time Time Text
Dl_CHAMMEL
DIM_CUSTOMER
DIM_CUSTTYPE
DIM_PERIOD
< Back | [es| DIM_PRODUCT cel
Select a dimension table =M!EM
REPORTHIERARCHY

8. The transaction table group is added to the model.
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E‘;‘, SAS Profitabiity Management - Bank_Model

File Edit “iew Help

Jiﬁl | |E:E§ 35 | @ by |M|:u:|el: IBank_Mu:udeI j

Transactions

W‘ Tranzachons |

| Period

Mewy table group

Behaviars P | | _PI
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‘ = H i ‘4. Define Transaction Table Groups

Transaction tables that have the same columns defined are organized into a table
group. A single SAS Profitability Management model is likely to have multiple table

groups. Multiple rules will likely use the same source table group. There must be one
transaction table for each period in a model.

Defining and populating groups of transaction tables is a two-part process:

1. Define a transaction table group.

2. Add transaction tables to a table group (and associate each transaction table
with a time period).

Related Topics:

. Select the periods whose transaction tables are included in cubes

. Define the display format for numbers

. Add a new period to the period dimensions table
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Transaction Table

There must be one transaction table for each period in a SAS Profitability Management model. For each table group, the
transaction tables must have the same columns defined. A single model is likely to have multiple table groups. Multiple rules
will likely use the same source table group. Transaction table layout is affected by the rule definition process (filter logic and
driver logic). A transaction table contains the following columns:

Name Maximum Length Description

Dimension_1 Char 32 Identifies the row (in a custom dimensions table) for this transaction
Dimension_2 Char 32 Identifies the row (in a custom dimensions table) for this transaction
Dimension_n Char 32 The number of dimensions referred to by a transaction table is optional

Numeric value that is used in a rule's driver formula to calculate the driver
guantity for a transaction
Numeric value that is used in a rule's driver formula to calculate the driver
quantity for a transaction

The number of columns that are used to calculate the driver quantity for a
transaction is optional

DriverQuantity 1  Numeric 8

DriverQuantity 2 Numeric 8

DriverQuantity_3  Numeric 8

In a transaction table, consider the following rules:

. Each column must have the length that is shown.

. The position of columns is arbitrary.

. The name of the column is arbitrary.

. The number of columns in a transaction table is arbitrary.

. A transaction table can contain other columns not specifically used by SAS Profitability Management.

The dimensions of a transaction are specified in custom dimensions tables. The following picture shows the mapping from a
sample transaction table to different custom dimensions tables:
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Transaction table

.

AMT | Count |

Custom dimensions tables

IS[=] B3

=

AzzignmentRule

1 2006_01_Actual | 1 ATM_CHK_Check balance
2 2006_G1_Actual
3 2006_G1_Actual
4 2006_01_Actual 1 v Y L1_Channel
5 2006_G1_Actual Feg_1078 > ERH ERH
E 2006_C7_Actus gt
i 2006_07_Actus
g 2005_01_Acty L1_Area L2 Country L3 State | L4 City 3
q 2005_01_Achy Azia Pacific Australia Australia Tate
10 2006_01_Actfe Azia Pacific Australia Australia Zetland
12 2006 (1) L1_CType | L2 CType L3 CType Al
13 2006_01. Buziness Retall Consumer Banking
14 2008_C1, 2 SRR Ruzinezz Small Rusiness Bankinn
L1_Product L2 Product
1 Credit Products B
Depogit Products b azs Market
m_buzz.Dim_customer Mature and Retired
| L1_Type | L2_LastHame | L3_FirgtH ame ﬂ ':lf::;lagtusiness S
1 0oo1 Perzonal Browning Lee A Busi £ P .
M — - C P & |um. uzipess E= ““N

Note: When transaction tables in different transaction table groups map to the same custom dimensions table, the column
names in the transaction tables must match. Otherwise, the table joins to create the OLAP cube will fail.

The following is a sample transaction table:

186



li'il_ ¥IEWTABLE: Pm_buzz.Load_trans_qla

Timne CuztlD Product | CustType Reqgion Channel AT Court AzzignmentBule ﬂ
1 2006_01_Actual 00005 CHE WER Feg_849 AT a1 1 ATM_CHE_Check balance
2 2006_01_Actual 00003 CHE. EEF Reg_281 AT 24 1 ATM_CHE_Check balance
3 2006_01_Actual 00025 CHE WER Reg_ 523 AT 20 1 ATM_CHE_Check balance
4 2006_01_Actual 00023 CHE MRT Reg_12 AT 38 1 ATM_CHE_Check balance
] 2006_01_Actual 00030 CHE WER Reg_1078 AT 93 1 ATM_CHE_Check balance
B 2006_01_Actual 00032 CHE WER Feg_858 AT 142 1 ATM_CHE_Check balance
7 2006_01_Actual 00037 CHE RPEB Reg_935 AT 186 1 ATM_CHE_Check balance
a 2006_01_Actual 00049 CHE MRT Reg_E99 AT 240 1 ATM_CHE_Check balance
/\ 2006 Actual E7 K. bl i b Reg_962 26 1 ATM_CHE-Check balar
71 Th k bal
99254 [2006_01_ActTal 16582 AN T Red~ TEL 4328 1 W _Fun &r
99285 | 2006_01_Actual 16377 AN WER Reg_ 7 TEL 1674 1 TEL_S&%_Fund Tranzfer
99266 | 2006_01_Actual 17021 SN FEI Reg_534 TEL 2196 1 TEL_S&%_Fund Tranzfer
99257 | 2006_01_Actual 17083 AN RPEB Reg_305 TEL FiEn 1 TEL_S&%_Fund Tranzfer
99268 | 2006_01_Actual 170594 AN MRT Reg_1003 TEL 4530 1 TEL_S&%_Fund Tranzfer
99253 | 2006_01_Actual 17478 AN WER Reg_&78 TEL 3945 1 TEL_S&%_Fund Tranzfer
99260 | 2006_01_Actual 17917 SAN (LR Reg_B85 TEL 1548 1 TEL_SAW_Fund Tranzfer
99261 | 2006_01_Actual 17385 AN EEP Reg_143 TEL 1471 1 TEL_S&%_Fund Tranzfer
99262 | 2006_01_Actual 12005 AN FEI Reg_ 531 TEL h2a9 1 TEL_S&%_Fund Tranzfer
99263 | 2006_01_Actual 18153 AN WER Reg_74 TEL R903 1 TEL_S&%_Fund Tranzfer
99264 | 2006_(1_Actual | 18251 SN WE R Reg_E53 TEL 4472 1 TEL_SA%_Fund Tranzfer
93265 | 2006_01_Actual 18301 AN AFF Reg_1038 TEL 21739 1 TEL_S&%_Fund Tranzfer
99266 | 2006_(1_Actual 18301 AN RPEB Reg_281 TEL E147 1 TEL_S&%_Fund Tranzfer —
4 | 3

Related Topics:

. Define a transaction table group

. Add transaction tables to a group (and associate each transaction table with a period)

. Select the periods whose transaction tables are included in cubes

. Define the display format for numbers
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SAS Profitability Management Tutorial

The SAS Profitability Management Tutorial will familiarize you with the basic business
profitability modeling concepts that are used in SAS Profitability Management. To
install the tutorial, perform the following steps:

1. Navigate to the following location: << Customer Install Depot Location>>
\abmproflcd\abmproflcd_doc.

2. Open en.zip and extract the file tutorial.zip to your local machine at the following
location:
C:\ <<Your Location>> \abmprofcint.

. Mame =
Open en.zip @E,mip

Ej]ia-EiD

!';[!Winzip - EN.Zip

File Acktions Options Help

Mame Tvpe
Extract tutorial.zip tutorial 2ip WinZip File
E:lindex.html HTML Docu
tab, <l AML Docurr
=, g #

3. Open tutorial.zip, and then extract its contents.

Mame =
Cpen tutorial i —— T3 utarial.zip

!';@!Winzip - tutorial.zip

File Actions ©Options Help

Marne T
Extract all files —l-Ecallcenter_qﬂlb.sas?bdat Sf
Ezadim_channel.sas?hdat =t
Eﬂdim_custnmer.sas?hdat T
B e, custbvpe, sas7h 51

4. View the file SAS Profitability Management_Tutorial.pdf to begin the tutorial.
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Use the supplied SAS tables as the source content for the tutorial.
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Add Users

To define SAS Profitability Management users in the SAS Management Console,
perform the following steps:

1.

10.

11.

12.

Log on to the SAS Management Console as an administrator.

The main window opens.

. Select the Foundation repository.

. Select Environment Management.

Right-click User Manager, and then select New k User.

Name the new user, and then enter other user information on the General tab.

. Click the Groups tab, and then select the group to which the user is to be

added.

. Click the Logins tab, and then click New.

Enter the new user's user ID on the network.

The New Login Properties window opens.

Leave the Password field blank (it comes from the network).

Leave the Confirm Password field blank (it comes from the network).
Select DefaultAuth for the authentication domain.

Click OK.

Note: You can leave the Authorization tab blank.
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Add Users

To define SAS Profitability Management users in the SAS Management Console, perform the following steps:

1. Log on to the SAS Management Console as an administrator.
The main window opens.

2. Select the Foundation repository.

3. Select Environment Management.

4. Right-click User Manager, and then select New # User.

%1 5A5 Management Conzole - abmmoe mi=] E3
File Edt “iew Action: Toolz: FRoadmaps Help
= m@Xx| D

Select the Foundation repositary W"II’I Foundation

@ SAS hanagement Conzole 1= |
Select Environment Management —=#=| Enviranmert Managemert

= Search i wigwy Al

@ Autharization Manager
243 Bl Manager
!',.l Data Library Manager

V| Showy Groups V¥ Show Users

qﬁ Metadata Manager

=T I Description Title |

Right-click User Manager

Select New > User

@ Schedule Manager SATLISERS

O rUELIC

LT Ry

lyste...

-

[ |

About Uzer Manager...

abminoe ha sas.com ;- 5561

5. Name the new user, and then enter other user information on the General tab.

Y. Hew User Properties Ed

General | Grnupsl Lu:uginsl Authu:urizatiu:unl

Q User

Mame the user ——— name:

Job Tile: |

Descrigtion: I

Ernail Type Address

Phiore
Address

[y | Edit | Delete |

Ok I Cancel

Help
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6. Click the Groups tab, and then select the group to which the user is to be added.

. Hew User Properties x|

Click the Groups tab ERErar Groups | Lnginsl .&uthurizatinnl

| g % Wi Al |

V¥ Search Parent Repositories

Available Groups: Membet of:

5.

L AEW Users -
Select the group —3= :T; PR Madeler
T Portal Admins Ll
X Portal Demos
:4; SAS General Servers “_""l
A ©A% System Services
2 RS Administrator
2 WRS Advanced User ;I

Propetties |

Ok I Cancel Help

7. Click the Logins tab, and then click New.
8. Enter the new user's user ID on the network.
The New Login Properties window opens.
9. Leave the Password field blank (it comes from the network).
10. Leave the Confirm Password field blank (it comes from the network).
11. Select DefaultAuth for the authentication domain.
12. Click OK.

Note: You can leave the Authorization tab blank.
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% Hew User Properties E4

Click the Leogins tab TERErEl | Sronpe Loging I Authnrizatiunl

Avthertication Comain I L=er IO I Pazsweard I
Hew Login Properties
Eriter Login information. Enter User [ds for Microsoft Windows
Click New m | : in the format of domainluserid. See help for details.
— few
Enter User ID on the network » Lzer ID: f
Leave Password hblank - Passywvord: |

Y

Leave Confirm Password blank Confirm Password: |

Select DefaultAuth = Authertication Domain: IDefaurt,&uth x| Hew

Ok I Cancel | Help |
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Value

Value is the calculated cost per transaction. The calculation is based on whether the
behavior table row that is accessed by an assignment rule contains a unit value or a
total value.

Unit Value

When a row in a behavior table contains a unit value, the driver formula
calculates the number of units that are involved in each transaction that is
selected by the selection criteria. Then, the cost per transaction (value) is
determined by multiplying the number of units by the unit cost (in the behavior
table) of the transaction.

Show an example

Total Value

When a row in a behavior table contains a total value, the driver formula
calculates the number of units that are involved in each transaction that is

selected by the selection criteria. Then, the cost per transaction is determined
in the following way:

1. The total number of units for all transactions (selected by the selection
criteria) is calculated by adding the number of units (as determined by
the driver formula) for each transaction (selected by the selection
criteria).

2. The cost per unit is calculated by dividing the total value (in the row in
the behavior table) by the total number of units.

3. The cost for each transaction (value) is calculated by multiplying the

cost per unit by the number of units (as determined by the driver
formula) for that transaction.

Show an example
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View the Audit Log

1.

Select View ¢ Audit Log.

The Audit Log window opens.

. To filter the audit log items, select a user, model, and operation from the drop-

down lists.

To view more detailed information, select one or more items, and then click
Details.

Another Audit Log window opens. If you selected more than one item, you can
move through the items by clicking Previous and Next. Click OK.

. To print items, select one or more items, and then click Print.

The Print window opens. Click Print.

. To copy items to the Microsoft Windows clipboard, select one or more items,

and then click Copy.

. Click OK.
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‘4— |8. View Reports

A summary report is a generated cube. A detail report is a cube that is generated on

the fly when you request to view it in the SAS Profitability Management Web Reporting
Client.

View a Summary Report

. Open a summary report

. Drill into a summary report

. Suppress the display of blank content

. Select specific values to display

. Change the number of rows or columns displayed

. Change heading colors

. Format displayed numbers

. Insert a graph

. Save a view of a report

View a Detail Report

. Open a detall report

. Drill into a detail report

. Suppress the display of blank content
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Your Turn

We want your feedback.

e If you have comments about this book, please send them to
yourturn@sas .com. Include the full title and page numbers (if
applicable).

e If you have comments about the software, please send them to
suggest@sas.com.
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